Watch Window

A Watch Window displays a collection of variables, their attributes, and live values, in a stand-alone window. The Watch Window feature can be accessed from the ToolboxST System Editor, as well as from the individual Component Editors. Once a Watch Window is created, it can be exported from and imported to .csv files.

➢ To open a stand-alone Watch Window

♦ From the Start menu, select All Programs, GE ControlST, ToolboxST, and Watch Window. The Watch Window dialog box displays.

➢ To create a Watch Window from the System Editor

♦ From the Tree View, right-click the system and select Insert New, Tool, and Watch Window.
The **New Watch Window** dialog box displays.

Enter a **Name** for the Watch Window, add a **Description** (optional), then click **OK**.

The new Watch Window displays in the System Tree View.

**Note** If this Watch Window is being opened for the first time, the list is empty. Add or import a new Watch Window.
To open an existing Watch Window

- From the **System Editor Tree View**, right-click the system and select **Insert Existing** and **Watch Window**.

The **Watch Window** dialog box displays.

To open a Watch Window from a Component Editor

- From the **Component Editor View** menu, select **Watch Windows**.

From the **File** menu, elect **Add New** or **Add Existing** to add a new or existing Watch Window.
Adding a Variable

Use the Add Watch Window Item Wizard to add a variable to a Watch Window.

➢ To add a variable

1. From the **System Editor Tree View**, double-click a **Watch Window** to open it. The <Watch Window name> dialog box displays.

2. From the **Watch Window Edit** menu, select **Add Variable** and **Using Add Wizard…** When the Welcome screen displays, click **Next**

Select the data source of the variables you wish to attach to the control.

- System Component
- Local WorkstationST
- DPC Server

Select the data source and click **Next**
If you selected System Component in the previous wizard, select the desired component from the drop-down list and click Next.

Click Add to display the Select a Variable dialog box.
From the list, either double-click a variable, or select one and click **OK**.

To remove a variable, select it and click **Remove**. When all variables have been added, click **Finish**.
Managing Variables

Once a variable has been added to a Watch Window, right-clicking the variable allows you to perform the following actions.

Add Variable allows you to add additional variables.

Select All selects all variables for removing, pasting, or copying to the clipboard.

Remove Variable(s) removes selected variables.

Go to Definition allows you to display the variable definition from its location.

Change Live Value allows you to change the live value when the Watch Window is online with the controller.

Copy to Clipboard allows you to copy the selected variable to the clipboard.

Paste allows you to paste a variable to another location, such as a Trender.

Add to Trender allows you to add selected variables to a Trender.

Organizing Watch Window Columns

◆ To organize columns in a Watch Window

From the View menu, select Organize Columns. The Organize Columns dialog box displays. Refer to Chapter 6, the section Organizing Columns.

Forcing Live Values

Warning

Logic forcing procedures can result in personal injury or death, if not strictly followed. Only adequately trained personnel should modify any programmable machine. Forcing of control logic for an operating process is strongly discouraged.

Forcing of protective functions is never permissible for an operating unit. All safety measures should be strictly enforced in conjunction with this procedure.

◆ To force the live value of a variable

1. From the Watch Window, double-click the live value of a selected variable. The Send Value dialog box displays.

2. Enter the desired value, select the Force Value check box, then click Send and Close.

The forced value is sent to the controller.
Reconciling Constant Differences

The Reconcile Constant Differences feature allows you to synchronize the live value and the initial value for constants. The live value is the value of the constant currently being used in the running controller. The initial value is the value of the constant in the ToolboxST configuration.

➢ To reconcile differences in the constants

1. From the File menu, select Reconcile Constant Differences. The Constants Reconciliation dialog box displays all constants in which the Live Value and the Initial Value are different.

2. Select the check box next to the correct value to synchronize the constant and click OK.

The constants are synchronized as follows.

• For constants in which the Initial Value was checked, the Initial Value is sent to the controller, making the Live Value equal to the Initial Value.

• For constants in which the Live Value was checked, the Initial Value is set equal to the Live Value.

Drag-and-drop Feature

Variables can be moved to other windows and editors using the drag-and-drop feature. For example, you can use the drag and drop feature to move:

• A block pin from the Block Diagram Editor to a Watch Window.

• A variable in the Watch Window to a block pin on the Block Diagram Editor, forming a connection.

• A variable from one Watch Window to another Watch Window, copying the selected variable into the target window.
The Watch Window tool only exports grid columns necessary to retrieve variable information. As an example, DatasourceName from the exported file is used to retrieve the variable's remaining properties from the system. User-defined columns such as User Comment are also included.

**Importing and Exporting**

A Watch Window can be imported to, or exported from a .csv file. From there, other components can use a previously selected collection of variables.

- **To export a Watch Window to a .csv file**
  1. From the Component Editor View menu, select Watch Windows. The Watch Windows for `<Watch Window name>` dialog box displays.
  2. From the dialog box, double-click the desired Watch Window. The `<Watch Window name>` dialog box displays.
  3. From the Watch Window File menu, select Export or click the Export Watch button 🔄. The Export Watch Window dialog box displays. Locate and select the desired folder and save the Watch Window as a .csv file.

- **To import a Watch Window from a .csv file**
  1. From the Component Editor View menu, select Watch Windows. The Watch Windows for `<Watch Window name>` dialog box displays.
  2. From the dialog box, double-click the desired Watch Window. The `<Watch Window name>` dialog box displays.
  3. From the Watch Window File menu, select Import or click the Import Watch button 🔄. The Import Watch Window dialog box displays. Locate and select the desired folder and save the Watch Window as a .csv file.

**Saving a Watch Window**

- **To save a Watch Window**
  1. From the `<Watch Window name>` File menu, select Save As. The Save Watch Window File dialog box displays.
  2. Save the Watch Window as a .watch file.
LiveView

LiveView allows you to display a graphical representation of live data from various sources in the system. LiveViews can be added to a ToolboxST system or component. Once added, they can be edited.

Adding and Opening LiveViews

➢ To add a LiveView from the System Editor

♦ From the Tree View, right-click the system and select Insert New. From the sub-menus, select Tool and LiveView.

The New LiveView dialog box displays.

Add a Name and a Description for the Live View, then click OK.
➢ To add an existing LiveView from the System Editor
  ♦ From the Tree View, right-click the system and select Insert Existing. From the sub-menus, select LiveView.

➢ To edit a LiveView from the System Editor
  ♦ From the Tree View, right-click a LiveView, then select Edit System Component.
To start a LiveView

♦ From the Tree View, double-click the LiveView item. The LiveView displays.

To add a LiveView from a Component Editor

♦ From the View menu, select LiveViews. The LiveViews dialog box displays.
From the File menu, select Add New. The New LiveView dialog box displays.

Enter a Name and a Description (optional), then click OK. The new LiveView displays in the LiveViews dialog box.
> To open an existing LiveView in the Edit Mode from the Component Editor

1. From the View menu, select LiveViews. The LiveViews dialog box displays.
2. Right-click the desired LiveView, then select View. The LiveView displays.

> To open an existing LiveView in Run mode from a Component Editor

1. From the View menu, select LiveViews. The LiveViews dialog box displays.
2. Right-click the desired LiveView, then select View. The LiveView displays.
**LiveView Editor Features**

The **Tools** window contains General and Animation controls.

The **Properties** window displays the properties of the selected control(s).

The **Log Control** displays error/informational messages.
**Standard Toolbar**

The standard toolbar contains the following buttons.

- Save
- Cut
- Copy
- Paste
- Delete
- Undo
- Redo
- Run the Liveview
- Stop the running Liveview
- Show / Hide the Event Viewer
- Show / Hide the Toolbox
- Show / Hide the Property Grid

**Layout Toolbar**

Additional layout buttons are as follows.

- **Align Lefts**
  The selected controls Lefts are made equal to left of the Primary selection

- **Align Centers**
  The selected controls horizontal center are aligned to the horizontal center of the Primary selection

- **Align Rights**
  The selected controls Rights are made equal to right of the Primary selection

- **Align Tops**
  The selected controls Top are aligned to the top of the Primary selection

- **Align Bottoms**
  The selected controls Bottom are aligned to the bottom of the Primary selection

- **Center Vertically**
  The selected controls are centered vertically to the panel

- **Center Horizontally**
  The selected controls are centered horizontally to the panel

- **Make Control Width Equal**
  The width of the selected controls are made equal to the primary selection

- **Make Control Height Equal**
  The Height of the selected controls are made equal to the primary selection

- **Tab Order**
  Displays Tab Order of each control

- **Full Screen**
  Toggles between full screen and normal mode

- **Advanced Mode**
  Toggles between Simple and Advanced Mode

- **Send to Back**

- **Bring to Front**

- **Control Width and Height**
  Both the width and height of the selected controls are made equal to the primary selection
**LiveView Controls**

The General controls are as follows.

- **Label** is a convention label control.
- **Live Value** is a live value as label text.
- **VarLive** is a splitter control variable name in the first half and a live value in the second half.

- **Setpoint Button** is a control to force a value to the associated variable.
- **Hyperlink Button** is a control to navigate to another LiveView, a .cfm file, or any web URL.
The Animation controls are as follows.

**Analog Meter** – the pointer is deviated with respect to the live value of the variable.

**Bar Graph** – the bar fills with the live value of the variable.

**Status Indicator** – indicates the status of a Boolean variable.
**Attaching a Variable**

Use the Add LiveView Item Wizard to add a variable to a LiveView.

- **To attach a variable**
  1. From the **Tools** window, either double-click or drag **Var:Live** onto the design surface.
2. The **Attach Variable Wizard** displays. From the welcome screen, click **Next**. The data source of the variable is selected from the next wizard screen.

Select either **System Component** or **OPC Server** as the data source of the variables to be added to the **LiveView**, then click **Next**.
If you selected **System Component** the previous screen as the variable data source, use the drop-down list to select the desired component, then click **Next**.

Click the **Add** button to display the **Select a Variable** dialog box.

Click the **Add** button to display the **Select a Variable** dialog box.
3. From the **Select a Variable** dialog box, select the desired variable, then click **OK**. The variable displays in the wizard screen.

Click **Finish** to add the selected variable to the LiveView.
Once variables have been attached to a LiveView by using the wizard, additional variables can be attached directly from the system component.

- **To attach additional variables**

  Right-click the variable property, then select **Attach Variable** and **From 'G1'**. The **Select a Variable** dialog box displays.

  Note You can also attach a variable by entering the variable name in the variable property.
**Saving a LiveView**

➢ To save a LiveView

From the **File** menu, select **Save As…**

**Variable Definitions**

It is possible to find and display a variable definition.

➢ To display a variable definition

Right-click the variable, then select **Go to Variable Definition**.
Control Constants

Control constants are special read-only variables that are important to key control algorithms. Control constants must always have a Global scope.

➢ To convert a variable to a control constant
1. From the Software tab, locate and select the variable to convert to a control constant.
2. From the Property Editor, locate the Scope property and verify it is set to Global.
3. From the Property Editor, change the value of the Control Constant property to True.
4. From the Property Editor, assign an Initial Value and edit to Property Editor. (Optional)

Control Constants Window

All control constants display in the Control Constants window, where the constants can be reviewed and the Initial Values can be modified.

➢ To display the Control Constants window
1. Open a Mark Vle Component Editor. From the View menu, select Control Constants.

Enter a new value into the Initial Value box. Initial Value is the only column that can be modified from the Control Constants screen.

Click to display the Modify Value dialog box.
Importing and Exporting Control Constants

The control constants for a controller can be exported to a comma separated value (.csv) file for external viewing and changes. Previously exported control constant files can be imported back into the controller. During an Import, the initial values of the control constants are updated according to the values in the .csv file. A sample .csv file is provided below to illustrate the output format:

```
NAME,VALUE,TYPE,UNITS,DESCRIPTION,FORMAT SPECIFICATION
ControlConstant3,6.234,REAL,,, 
ControlConstant2,55,DINT,,, 
ControlConstant6[0],true,BOOL,,, 
ControlConstant6[1],false,BOOL,,, 
ControlConstant6[2],true,BOOL,,, 
ControlConstant6[3],false,BOOL,,, 
ControlConstant6[4],true,BOOL,,, 
ControlConstant4,8769.876,LREAL,,, 
ControlConstant5[0],20.1,REAL,,, 
ControlConstant5[1],23.2,REAL,,, 
ControlConstant5[2],34.5,REAL,,, 
ControlConstant5[3],40.6,REAL,,, 
ControlConstant5[4],55.5,REAL,,, 
ControlConstant1,1,BOOL,,, 
```

**Note** If any fields other than the Value field have been modified in the .csv file, the control constant is not updated.

➢ **To export control constants to a .csv file**

- Open the Control Constants window. From the File menu, select Export to csv. In the dialog box that displays, select a location for the exported data and click Save.

➢ **To import control constants from a .csv file**

- Open the Control Constants window. From the File menu, select Import from csv. In the dialog box that displays, select a location for the imported data and click Save.

**Note** During an Import, the Override Value property of all control constants that are linked to a library and have a different initial value from the value in the .csv file are set to True.
**I/O CheckOut**

The I/O CheckOut feature allows you to verify the operation of each I/O point.

- To display the I/O CheckOut points
  - From the Hardware tab Tree View, right-click a board.

From the View menu, select I/O CheckOut. The I/O CheckOut for [component name] screen displays.
Chapter 7 Working Online With a Mark VIe Component

The Mark VIe component is used for control, protection, and monitoring of turbine and driven load equipment. Vital subsystems, such as servo control, vibration protection, and synchronization are embedded in the I/O with on-board processors to optimize performance.

The ToolboxST configuration is the maintenance software tool for Mark VIe components. The system has a CompactPCI controller with networked I/O. The I/O processors are located on the terminal boards instead of in centralized board racks. This configuration digitizes the signals on the terminal boards, which can be mounted local or remote, individually or in groups.

Connecting to a Controller

➢ To connect to a controller

♦ From the System Editor, open a Mark VIe Component Editor. From the Device menu, select Online or from the System Editor, open a Mark VIe Component Editor. From the toolbar, click the Online button.

If you are connecting to a simplex controller, a connection is automatically established with the R controller. In a dual or Triple Modular Redundant (TMR) configuration, a dialog box displays to select either a redundant controller (either R, S, or T) or the controller currently designated as the supplier of initialization data.
When the ToolboxST application is connected to a Mark VIe component, operating state and equality information is available from the Status tab of the Component InfoView window. When used in a redundant controller configuration, the status is shown individually for each controller in the redundant set.

The color on the Status tab indicates the overall state of the controller.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Status</th>
<th>Sub-Feature Status</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workstation5 Service</td>
<td>OK</td>
<td></td>
<td>All configured features are installed and running.</td>
</tr>
<tr>
<td>Configuration Equality</td>
<td>Equal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarm Server</td>
<td>OK</td>
<td></td>
<td>Alarm Server is running with no errors.</td>
</tr>
<tr>
<td>EGD Configuration Server</td>
<td>OK</td>
<td></td>
<td>Feature is running</td>
</tr>
<tr>
<td>Network Monitor</td>
<td>OK</td>
<td></td>
<td>Feature is running</td>
</tr>
<tr>
<td>OPC AE Server</td>
<td>OK</td>
<td></td>
<td>OPC AE Server is Running</td>
</tr>
<tr>
<td>Time Synchronization System</td>
<td>OK</td>
<td></td>
<td>NTP Peer is synchronized</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Color</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>All controllers functioning normally.</td>
</tr>
<tr>
<td></td>
<td>- Control state is controlling</td>
</tr>
<tr>
<td></td>
<td>- Controller Equality equal</td>
</tr>
<tr>
<td></td>
<td>- DDR Equality equal</td>
</tr>
<tr>
<td>Yellow</td>
<td>One or more of the following:</td>
</tr>
<tr>
<td></td>
<td>- Control state not controlling</td>
</tr>
<tr>
<td></td>
<td>- Controller equality not equal</td>
</tr>
<tr>
<td></td>
<td>- DDR equality not equal</td>
</tr>
<tr>
<td></td>
<td>- Frame Idle time &lt; 20%</td>
</tr>
<tr>
<td>Red</td>
<td>One or more of the following:</td>
</tr>
<tr>
<td></td>
<td>- Control state is failed</td>
</tr>
<tr>
<td></td>
<td>- Controller equality has a major difference</td>
</tr>
</tbody>
</table>
The following example displays the unequal state for a dual redundant control. The DDR Equality attribute text is orange to indicate that DDR Equality is not equal, and the Controller Equality attribute text is red to indicate that a major difference exists. Since the Controller Equality attribute takes precedence over the DDR Equality attribute as indicated in the above table, the Status tab is red.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>R Controller</th>
<th>S Controller</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control State</td>
<td>Controlling</td>
<td>Controlling</td>
</tr>
<tr>
<td>Controller Equality</td>
<td>Major Difference</td>
<td>Major Difference</td>
</tr>
<tr>
<td>DDR Equality</td>
<td>Not Equal</td>
<td>Not Equal</td>
</tr>
<tr>
<td>Designated Controller</td>
<td>R Controller</td>
<td>R Controller</td>
</tr>
<tr>
<td>LDH Communicator</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Frame Idle Time [%]</td>
<td>70.2</td>
<td>70.2</td>
</tr>
<tr>
<td>Number of Forced Variables</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Heart Beat</td>
<td>320877</td>
<td>122204</td>
</tr>
</tbody>
</table>

Connected to G1-R
**Controller Attributes**

Control State indicates the current state of the controller. When a controller is turned on, it transitions through several states before arriving at the normal controlling state. Valid Control States are as follows:

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Powerup</td>
<td>Power up controller</td>
</tr>
<tr>
<td>Master initialization</td>
<td>Initialize controller</td>
</tr>
<tr>
<td>Designated controller determination</td>
<td>Determine which controller is designated in a redundant controller configuration</td>
</tr>
<tr>
<td>Data initialization</td>
<td>Perform initialization of non-designated controllers with NVRAM, command variables, and constants</td>
</tr>
<tr>
<td>Inputs enabled</td>
<td>Wait in this state for all required I/O packs to start transmitting inputs</td>
</tr>
<tr>
<td>Input voting</td>
<td>Check voting inputs prior to execution of application code</td>
</tr>
<tr>
<td>Exchange initialization</td>
<td>Populate redundant controllers with dc state variables prior to voting</td>
</tr>
<tr>
<td>Exchanging</td>
<td>Exchange state variables so that a controller joining a running system won’t have a step in its initial calculations</td>
</tr>
<tr>
<td>Sequencing</td>
<td>Turn on the application code and execute each task at least once before driving outputs</td>
</tr>
<tr>
<td>Controlling</td>
<td>Turn on outputs</td>
</tr>
<tr>
<td>Loading</td>
<td>Online load is in progress</td>
</tr>
<tr>
<td>Load complete</td>
<td>Online load has finished. Wait for re-synchronization of redundant controllers</td>
</tr>
<tr>
<td>Fail</td>
<td>Failure has occurred.</td>
</tr>
</tbody>
</table>

If the indicated Control State is not Controlling, the ToolboxST application can provide additional information as follows:

Move the mouse pointer over the Control State.

Information about the current state displays.

Or, double-click Control State to display the information in a separate window.
Controller Equality indicates whether equality exists between the software configuration in the ToolboxST application and the configuration currently running in the controller. Valid states are Equal, Not Equal, and Major Difference. Refer to the section, Downloading to a Controller.

DDR Equality indicates whether equality exists between the Dynamic Data Recorder configuration in the ToolboxST application and the configuration currently running in the controller. Valid states are Equal and Not Equal.

Designated Controller indicates the controller that is designated as the supplier of initialization data to the other controllers.

UDH Communicator indicates the controller responsible for communicating on the Unit Data Highway (UDH) for the Mark VIe component. The UDH Communicator performs tasks such as sending the EGD exchanges and alarms produced by the device.

Frame Idle Time is the percentage of CPU time left in the controller after the critical control functions of input, compute, and output have been completed. If there is less than 20% idle time, the status is shown in yellow.

System Idle is the percentage of CPU time left in the controller after all functions have been completed. It accounts for the critical control functions, as well as background processing and toolbox communication overhead.

System Idle Time Shows:

Number of Forced Variables displays the number of forced variables in the controller.

---

Warning

Logic forcing procedures can result in personal injury or death, if not strictly followed. Only adequately trained personnel should modify any programmable machine. Forcing of control logic for an operating process is strongly discouraged. Forcing of protective functions is never permissible for an operating unit. All safety measures should be strictly enforced in conjunction with this procedure.

Heart Beat indicates whether the controllers are exchanging the Control state variables. If the number shown is incrementing, the Control state variables are being exchanged.

Controller Time shows the time that the controller is using.
## Downloading to a Controller

The ToolboxST application is used to configure both a Mark VIe component and its distributed I/O modules. Both the component and the I/O modules have four items of software that can be downloaded:

**Boot Loader** starts the operating system for the controller and modules, much like the BIOS on a desktop computer. Changes to the boot loader are very infrequent.

**Base Load** contains the operating system for the controller and I/O modules. While changes to the base load are more likely than changes to the boot loader, they still occur infrequently.

**Firmware** provides the functionality of the controller and I/O modules. It can be updated over the lifetime of the controller to incorporate new features and bug fixes.

**Application Code** contains the configuration of the controller as created in the ToolboxST application. Whenever a change is made to the configuration, the application code must be downloaded. There are two types of application code download, online and offline. An online download, which is common, changes the configuration without interrupting control; the new configuration takes effect between control frames. An offline download requires a controller restart, and is much less frequent. The type of download needed is determined by the types of changes that have been made to the controller configuration.

---

### Warning

Boot loader, base load, firmware, and offline application code downloads all require the target device to be restarted. Before downloading new code to a controller, take necessary steps to secure the controlled equipment to prevent equipment damage and/or personal injury.

---

## Download Command

The Download item in the Device menu displays a submenu of commands. Besides the Controller Initial Setup and Download Wizard commands, the following commands are available:

**Controller Flash Boot Loader** is used to install the controller’s boot loader on a CompactFlash™ memory card. To use this command, you must have a compatible CompactFlash reader attached to your computer.

**Update Dynamic Data Recorders** updates the standalone data collectors that can be reconfigured without affecting any of the control code.

**View / Set Time** is used to set the time on a controller.
Controller Setup

The Controller Setup wizard prepares a controller for use by configuring its IP address and redundancy information. A controller cannot communicate on a network until these setup tasks are complete.

➢ **To set up a controller**

1. Connect a serial cable from the main board of the controller to a free serial port on your computer.

2. Open the Mark VIe Component Editor for the controller to be configured.

3. From the Device menu, select Download, and then Controller Setup. When the Welcome window displays, click Next to continue.

![Controller Setup Wizard]

Click Next to continue.
Select the desired Channel, then click Next to continue. A progress dialog box displays the status of the setup.

If Format Flash is selected, click Next to re-program the selected CompactFlash.
Click the Scan button to search for available CompactFlash cards.

To configure TCP/IP Settings, select the available channel(s), then enter a Host Name, a Gateway IP Address, an IP Address, and a Subnet Mask for each.

Click the Finish button.

Note If the controller is configured as either simplex or dual, some channels may not be available.
**Download Wizard**

The Download Wizard is the primary method of transferring software to a Mark VIe component and its distributed I/O modules over an Ethernet connection. The wizard can automatically examine the configuration of the system to locate out-of-date software, or you can manually select individual items to download.

---

**Warning**

Boot loader, base load, firmware, and offline application code downloads all require the target device to be restarted. Before downloading new software to a controller, take necessary steps to secure the controlled equipment to prevent equipment damage and/or personal injury.

---

➢ **To download software to a controller**

1. Open a Mark VIe Component Editor. From the Device menu, select Download, and then Download Wizard to display the Download Mark VIe Controller wizard.

2. If you have changed configuration settings since the last Build operation, a message box displays indicating that the software is out of date. Click Yes to build the current configuration. The Download Mark VIe Controller wizard opens.

3. When the Welcome Wizard displays, click Next.

If the Scan I/O checkbox is selected, the scan command determines whether I/O module software needs to be downloaded.
When checked, ToolboxST will download a backup file of the configuration to the controller to facilitate disaster recovery by doing an upload. It is recommended that this check box is left checked.

Click Next.

Downloading application code offline will shut the selected controller(s) down. This will result in a process trip if running. I/O outputs will change during this operation. Ensure that the process is secure prior to continuing.
4. When the download has completed, click **Finish** to close the wizard. In the Component InfoView, click the **Log** tab and review the status messages to check for potential warnings or errors that may have occurred during the download.

**Attention**

If the configuration being downloaded contains I/O packs with IDs that are different from the currently running configuration, incorrect firmware can be installed to some I/O packs. If this occurs, confirm that the controller is running the new configuration, restart the entire system, then restart the ToolboxST Download Wizard.

**Note** The APP_STATE block can prohibit a download and restart of the controller. In that instance, a Warning displays in the Component InfoView and the Download Mark VIe Controller wizard displays the prohibited download.
Dual Controller Download

The ToolboxST application supports downloading controllers that have dual redundancy. This feature allows you to select one of the two controllers to download, then provides a configured time period to review the changes running on the downloaded controller. Based on that review, the changes can either be downloaded with the new configuration or reverted to the other controller. That controller assumes control and the previously running configuration is restored on the downloaded controller.

➢ To download a dual controller

1. From the Download Mark VIe Controller wizard, select a dual controller to download. The Mark VIe Dual Online Download Manager displays with the R Controller designated to download first.

2. If you do not select the recommended First Download, a message box displays.
If you selected the recommended First Download, the selected controller is downloaded.

The Accept and Revert buttons become available, and a two-minute timer begins.

If the changes are okay, click the Accept button.

**Note** During this time period, the controller Editor window displays to allow you to confirm that the code changes being downloaded are functioning properly. You can navigate the configuration, as well as access the Trender, Watch Window and LiveView features.

3. If you are not satisfied with the code changes during the two-minute time period, click the Revert button. This causes the second controller to become the designated controller and causes the first controller to revert its running configuration to the previous version.
If you initiate a download after performing the revert function, the second controller displays as the designated controller.

**Note** If you do not click either the Accept or Revert buttons during the two-minute time period, the revert function is automatically invoked.
Upload Wizard

The ToolboxST application can retrieve existing configuration information from a Mark Vle component using the upload wizard. When a configuration is uploaded, it is stored as a new Mark Vle component in the currently open system. The uploaded configuration is useful as a reference for comparisons with other components and for retrieval of existing code.

➢ To upload the configuration from a Mark Vle component

1. Open a Mark Vle Component Editor. From the Device menu, select **Upload** to display the **Upload Controller** wizard.

2. When the Welcome Wizard displays, click **Next**. If the Mark Vle is configured as a redundant component, the following page displays with an option button for each available redundant component.

Select a controller and click **Next**.
3. When the upload completes, click **Next**.

Click **Finish**.
Controller Diagnostics View

The Controller Diagnostics View displays diagnostic messages for a controller component. Diagnostic messages are errors or warnings that occur in the hardware component and could cause the component to function improperly. Retrieving these messages should be one of first steps in diagnosing any problems with hardware, communications, or other related ToolboxST subsystems.

➢ To open Controller Diagnostics view

1. From the Main menu, select View.
2. From the View menu, select Controller and Controller Diagnostics.

The Controller Diagnostics dialog box displays.
I/O Diagnostics View

The I/O diagnostics view displays diagnostic messages for a component hardware I/O module. Retrieving these messages should also be one the first step in diagnosing any problems with hardware I/O.

- **To open I/O Diagnostics view**
  1. From the **Main** menu, select **View**.
  2. From the **View** menu, select **Diagnostics**, then **I/O Diagnostics**. The I/O Diagnostics View displays.

For more information, refer to Chapter 6, the section *Diagnostics Tab*. 

![I/O Pack Diagnostics](image)
Administer Totalizers

Each Mark VIe controller maintains a set of 64 counters in non-volatile RAM (NOVRAM) known as Totalizers. Each Totalizer counts the number of times that a particular event has occurred. Events are assigned to Totalizers by configuring a Totalizer block. Only one Totalizer block is allowed per controller. Any user may view the current values of the Totalizers, but to protect data integrity, a special password from GE is required to change them.

**Note** Before modifying Totalizer values in a redundant controller, connect to the R controller and make sure all other redundant controllers are healthy and communicating.

➢ **To view Totalizer values**

1. Establish a connection to the R controller. For more information, refer to the section, *Connecting to a Controller*.

2. From the **Device** menu, select **Administer Totalizers** to open the **View/Set Totalizers** dialog box.

The name of the **Totalizer block pin** connected to the totalizer. (If blank, the Totalizer has not been configured.)

The name of the variable connected to a configured pin.

The current value of the counter. The values displayed are retrieved live from the controller and are updated once per second as long as the dialog box is open.

Click here to close the dialog box.
Totalizer Passwords

All users can view Totalizer values, but modifying the values requires a temporary password obtained from GE Energy.

Note Totalizer passwords are specific to the connected redundant controller (R, S, or T) and cannot be used on other controllers.

➢ To request a Totalizer password

1. Establish a connection to the R controller. For more information, refer to the section, Connecting to a Controller.

2. From the Device menu, select Administer, and then Totalizers to open the View/Set Totalizers dialog box.

3. Under Totalizer Identifier and Password, click the Request button. A file named Totalizer_ID.txt is created in the same folder as the controller configuration files on your disk. Open the file in Notepad.

To obtain a password follow the appropriate directions.

Copy the password to the Windows clipboard, then return to the View/Set Totalizers dialog box.

Paste the password in the Password: text box. If the password is valid, a countdown timer displays to indicate the time remaining before the password expires.

Note Totalizer passwords are usually valid for 24 hours from time of creation.
Modifying Totalizer Values

Once you have entered a valid password, you can modify Totalizer values. (For assistance with Totalizer passwords, refer to the section, Totalizer Passwords.)

➢ To modify a Totalizer value

♦ Open the View/Set Totalizers dialog box and enter a valid password.

From the Totalizers list, click the Totalizer to change.

Click the Modify Selected button to display the Modify Totalizer Value dialog.

Enter a new value for the Totalizer in the New Value text box, and click OK.

The value is immediately sent to the controller.
Chapter 8 Finder

The Finder is a separate window in the toolbox, which contains several useful tools. It can help you find items, such as text, overrides, differences, and variable usage from the different types of components.

➢ To open the Finder

♦ From the toolbar, click the Finder button.

- or -

♦ From the Edit menu, select Find.

When a search is completed, the results display on the Find Results tab of the Component InfoView. To jump directly to a location, double-click it in the list.
### Find Methods

A variety of find methods are available that control how the text entered in the Find box is matched to text in the ToolboxST application.

**Anywhere** finds the specified text anywhere within a searchable text string.

<table>
<thead>
<tr>
<th>A search for</th>
<th>matches</th>
<th>but does not match:</th>
</tr>
</thead>
<tbody>
<tr>
<td>abc</td>
<td>abc</td>
<td>abdc</td>
</tr>
<tr>
<td>abcde</td>
<td></td>
<td>ab</td>
</tr>
<tr>
<td>xyzabc</td>
<td></td>
<td>bc</td>
</tr>
<tr>
<td>zabcz</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Begins with** finds the specified text only at the beginning of a searchable text string.

<table>
<thead>
<tr>
<th>A search for</th>
<th>matches</th>
<th>but does not match:</th>
</tr>
</thead>
<tbody>
<tr>
<td>abc</td>
<td>abc</td>
<td>xyzabc</td>
</tr>
<tr>
<td>abcde</td>
<td></td>
<td>abdc</td>
</tr>
<tr>
<td>ab</td>
<td></td>
<td>ab</td>
</tr>
<tr>
<td>bc</td>
<td></td>
<td>bc</td>
</tr>
</tbody>
</table>

**Ends with** finds the specified text only at the end of a searchable text string.

<table>
<thead>
<tr>
<th>A search for</th>
<th>matches</th>
<th>but does not match:</th>
</tr>
</thead>
<tbody>
<tr>
<td>abc</td>
<td>abc</td>
<td>abcd</td>
</tr>
<tr>
<td>abcde</td>
<td></td>
<td>ab</td>
</tr>
<tr>
<td>ab</td>
<td></td>
<td>bc</td>
</tr>
</tbody>
</table>

**Match Exactly** finds the specified text only when it is exactly equal to an entire searchable text string.

<table>
<thead>
<tr>
<th>A search for</th>
<th>matches</th>
<th>but does not match:</th>
</tr>
</thead>
<tbody>
<tr>
<td>abc</td>
<td>abc</td>
<td>abcd</td>
</tr>
<tr>
<td>xyzabc</td>
<td></td>
<td>ab</td>
</tr>
<tr>
<td>ab</td>
<td></td>
<td>bc</td>
</tr>
</tbody>
</table>

**Match Whole Word** finds the named text only when it is exactly equal to an entire word of a searchable text string, meaning it is surrounded on both sides by either punctuation or white space.
<table>
<thead>
<tr>
<th>A search for</th>
<th>matches</th>
<th>but does not match:</th>
</tr>
</thead>
<tbody>
<tr>
<td>abc</td>
<td>abc</td>
<td>abcde</td>
</tr>
<tr>
<td></td>
<td>abc cde</td>
<td>xyzabc</td>
</tr>
<tr>
<td></td>
<td>spell your abc’s.</td>
<td>abdc</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ab</td>
</tr>
<tr>
<td></td>
<td></td>
<td>bc</td>
</tr>
<tr>
<td></td>
<td></td>
<td>spell your abc’s.</td>
</tr>
</tbody>
</table>

**Wildcards** is similar to Match Exactly, except any single letter can substitute for a ? character and any sequence of zero or more letters can substitute for a * character.

<table>
<thead>
<tr>
<th>A search for</th>
<th>matches</th>
<th>but does not match:</th>
</tr>
</thead>
<tbody>
<tr>
<td>a?c</td>
<td>abc</td>
<td>abdc</td>
</tr>
<tr>
<td></td>
<td>adc</td>
<td>bc</td>
</tr>
<tr>
<td></td>
<td></td>
<td>abc cde</td>
</tr>
<tr>
<td></td>
<td></td>
<td>abcde</td>
</tr>
<tr>
<td></td>
<td></td>
<td>xyzabc</td>
</tr>
</tbody>
</table>

| a*           | abc                     | bc                            |
|              | adc                     | cde abc                       |
|              | abcd                    |                               |
|              | ab                      |                               |
|              | abc cde                 |                               |

**Regular Expressions** processes the text entered in the Find box as a regular expression (sometimes abbreviated regex). A regular expression is an advanced system of wildcards used to match a specific set of text. The ToolboxST configuration supports a standard set of regular expression commands similar to many popular third-party tools. While a detailed discussion of regular expression syntax is out of the scope of this document, there are many excellent books and online resources available with details about regular expressions.

<table>
<thead>
<tr>
<th>A search for</th>
<th>matches</th>
<th>but does not match:</th>
</tr>
</thead>
<tbody>
<tr>
<td>[cvm]at</td>
<td>cat</td>
<td>sat</td>
</tr>
<tr>
<td></td>
<td>cats</td>
<td>bat</td>
</tr>
<tr>
<td></td>
<td>vat</td>
<td></td>
</tr>
<tr>
<td></td>
<td>rat</td>
<td></td>
</tr>
<tr>
<td></td>
<td>mat</td>
<td></td>
</tr>
</tbody>
</table>

| (Mon|Tues|Wednes|Thurs|Fri)day | Monday | Tuesday | Wednesday | Thursday | Friday | Fridays |
|      |       |       |       |         |       |       |       |       |       |         |
|      |       |       |       |         |       |       |       |       |       |         |

| var[0-9]+    | var0 | varx |
| var9 | var7a |
| var7 | var |
| var48 |       |

| var[a-zA-Z]* | var | var5 |
| variable | var! |
| var2222 |       |
Replace Options

Besides performing simple searches, the Finder also supports search-and-replace operations.

➢ To display the Replace options

♦ In the Finder window, click the Replace button. The window expands to include new options.

![Diagram of the Finder window with Replace options]
Chapter 9 Trender

The Trender is a tool used to capture and display trend graphs of variables in the system. It can collect and display values in real time from controllers and other sources, and can display data collected by high-speed coherent data collection systems, such as capture buffers and dynamic data recorders. The Trender also can display previously captured data from a saved data file.

Accessing a Trender Window

Before you can analyze data trends, you must first open a Trender window. A Trender window displays a collection of traces and data that is saved between uses. You can open a Trender window from inside the ToolboxST application or separately from the Start menu. If you open a Trender window from inside the ToolboxST application, the window is stored inside a component or the system, and you can create as many Trender windows as necessary. If you open the Trender from the Start menu, files are saved with a .trend file extension.

➢ To create a Trender window outside the ToolboxST application

♦ From the Start menu, select All Programs, GE Control ST, and ToolboxST. Click Trender. A new Trender window displays.
To create a Trender window from the System Editor

♦ From the Tree View, right-click the system name, then select Insert New, Tool, and Trender. A new Trender window displays.

To create a Trender window from a Component Editor

♦ From the Component Editor, click Device and select Trenders. A new Trender window displays.

To save a Trender window

♦ From the Trender toolbar, select the Save button. If you opened the current Trender window from within the ToolboxST application, the Trender window saves automatically. If you opened the Trender window from the Start menu, the Trender window saves to a file.

Note While Trender windows opened from the Component Editor are associated with one particular component for storage purposes, they are not restricted to trending only that component, and may be used to monitor any variables.
Trender Window Features

**Trender toolbar** contains commands for commonly used tasks in the Trender window.

**Graph View** contains the trend graphs, which display the values represented by each trace.

**X-Axis markers** designate alarm and event times.

**Property Editor** allows you to change settings that affect the capture and display of data.

**Data toolbar** contains commands that manipulate the current data.

**Tracess tab** displays traces currently being monitored by the Trender window.

**User Note tab** allows you to save comments, instructions, and notes about the current chapter.

**Sources tab** displays sources where data is collected.

**Events tab** lists all events that have occurred during the current chapter.

**Auxiliary View** contains tabs that display information about the current data.

**Mode Indicator** displays the current mode (Live or Replay).
**Trender Toolbar**

*Note* The Trender toolbar may have fewer buttons if the current Trender window was opened from the ToolboxST application.

**Data Toolbar**

*Note* The buttons available on the Data toolbar may vary according to the current trace source type.
Working in Trender

**Acquiring Data**

Before you can analyze data, you must import it into a Trender window. Variables can be added to the Trender window live, from capture buffers, or from static files. While you may add as many variables as you like to a given Trender window, all of them must come from the same type of data source. (For example, you cannot display both live and static file variables simultaneously.)

**Adding Traces**

The Trender represents each variable with a trace. (The term trace is used since the Trender works similarly to a digital storage oscilloscope, which displays data by tracing a line across the screen as values are acquired.) As you add traces to a Trender window, the new traces display in the Traces Tab. (Refer to the section, *Traces*.)

➢ To add traces

1. From the **Edit** menu in the **Trender** window, select **Add Traces**. If there are currently no traces on the Trender, the **Trender – Add Trace Wizard Welcome** screen displays. From the **Welcome** screen, click **Next** to continue.

2. From the following wizard screen, select the data type you wish to trend.

Historical data is stored in all Historians associated with the currently configured controller.

Static data is stored in .csv files in the currently configured controller.
3. From the next wizard screen, select the data source from which to add the variables to trend.

- System Component
- Local WorkstationST
- OPC Server

4. From the next wizard screen, select the specific component from which to select the variables to trend.

Component: G1

5. From the next wizard screen, select the time period at which the variables will trend.

Period: 40, 80, 160, 320, 640, 1280, 2560, 5120
The final wizard screen allows you to select variables to trend.

Click the **Add** button to display the **Select a Variable** dialog box.

Select a variable, then click **OK**.
The selected variable displays in the wizard screen. Click the **Add** button.

If there are already traces on the Trender, you can add additional traces from the same component.

1. From the **Edit** menu, select **Add Traces**. The **Select a Variable** dialog box displays available variables for that component.
2. Add variables from a different component by clicking the drop-down button next to the **Add Traces** button.

**Note** You can add traces from the currently selected component or add traces from a new component by selecting Add using Add Trace Wizard from the drop-down list.

The selected variable displays in the **Traces** tab in the Trender window’s **Auxiliary View**.
Live Trends

When a Trender window contains live trends, it displays the incoming data onscreen in real time. Live trends are useful for monitoring systems in continuous operation.

➢ To add one or more traces from a live source

1. If the Trender window to which you would like to add the trace is not already open, refer to the section, Accessing a Trender Window.

2. From the Edit menu, select Add Traces. (or click the Add Traces button on the data toolbar). If there are already traces on the trender, the Select a Variable dialog box for the current data source displays, which you can use to select the variables to monitor. If there are no traces on the trender, the Add Trace Wizard displays. If there are traces and you would like to add traces for a different live data source, you can also invoke the Add Trace Wizard by clicking the drop-down list attached to the Add Traces button.

3. If this is the first trace added to the Trender window, the Add Trace Wizard prompts you for the type of trend to configure. Select Live, then click Next.

4. Select System Component, then click Next.

5. If you did not open the current Trender window from the ToolboxST application, the Add Trace Wizard prompts you for the name of the system file that contains the source component. Click the Browse button to locate the system file, then select Next.

6. Select the component from which you wish to trend variables, then click Next.

7. Select the sampling period you wish to use, then click Next. (The sample period represents the time in milliseconds between samples, so larger numbers result in fewer samples.)

8. From the next wizard screen, click the Add button to display the Select a Variable dialog box, then select one or more variables to monitor. When you are finished, click OK in the Select a Variable dialog box, then click Finish in the wizard screen. The newly created traces display in the Traces tab.
**Triggered Live Trends**

The Trender supports triggered live trends, which allow you to collect incoming data for specific triggered events in the control system. A triggered trend can capture data for a predetermined period before and after the trigger event occurs.

- **To configure a triggered trend**
  1. Add a live trend, as described previously.
  2. From the **File** menu, select **Properties** or click the **Trender Properties** button. The **Settings** dialog box displays.

  ![Triggered1 Settings](image)

  - **Axes**
    - Left Axes: 1
    - Right Axes: 0
    - Show Variable Names: False
    - Show Variable Names When Printing: True
  - **FFT Options**
    - Between Cursors: False
    - Padding Factor: 1X
    - Remove Mean: False
    - Windowing Mode: None
  - **Misc**
    - Enable Historical Fill: True
    - Time Zone: Site
  - **Saving**
    - Save Data: True
  - **Triggered Recording**
    - Max Captures: 5
    - Post-trigger Time: 00:00:05
    - Pre-trigger Time: 00:00:05
    - Trigger Compare: GT
    - Trigger Mode: Edge
    - Trigger Trace: TrendVars.TrendVar0001
    - Trigger Value: 0

  **Between Cursors**
  When creating the FFT of a time-based trace in replay mode use just the data between the cursors.

  3. Enter values for the **Triggered Recording** properties.
**Capture Buffer Trends**

Many components feature different methods of high-speed synchronous data capture. While each method addresses different needs, all methods are accessed as capture buffers in the Trender because they have similar underlying data collection mechanisms.

- **To add one or more traces from a capture buffer**
  1. If the Trender window to contain the new trace is not already open, refer to the section, *Accessing a Trender Window*.
  2. From the Edit menu, select Add Traces. The Add Trace wizard displays.
  3. If this is the first trace added to the Trender window, the Add Trace wizard prompts you for the type of trend to configure. Select Capture Buffer / Dynamic Data Recorder, and then click Next.
  4. Select the component from which to trend variables, then click Next. A list of all available capture buffers displays.
  5. Select one capture buffer, and then click Finish. All of the variables from the selected buffer convert into traces and the Trace tab is updated to reflect the changes.

**Static File Trends**

In addition to acquiring data from a component, the Trender can also display data from a static file stored on a hard disk. Four formats: Data Collection and Analysis (.dcaST), Comma Separated Value (.csv), COMTRADE, and GE Control System Toolbox Trend (.trn) are currently supported as static file sources. While each of these formats is unique, the procedure to add a trace is identical for all.

- **To add one or more traces from a static file**
  1. If the Trender window to contain the new trace is not already open, refer to the section, *Accessing a Trender Window*.
  2. From the Edit menu, select Add Traces. The Add Trace wizard displays.
  3. If this is the first trace added to the Trender window, the Add Trace wizard prompts you for the type of trend to configure. Select Static, and then click Next.
  4. Select the type of data source to import from and click Next to display an Open dialog box.
  5. Select the desired static file source, then click Open.
  6. The Select Variables wizard page displays. Click the Add button to display the Select a Variable dialog box. The ToolboxST application analyzes the selected file and displays a list of available variables. Select one or more variables to convert to traces. When you are finished, click OK in the Select a Variable dialog box, then click Finish in the wizard. The newly created traces display on the Trace tab.
Obtaining Data

As they depend on the presence of a controller, live and capture buffer traces do not initially contain any data. (The data from static file traces is automatically imported and displays as soon as the trace is added.) Once connected to the controller, the procedure for obtaining data depends on the type of traces present. Data from live traces is captured in much the same way that a video recorder operates (with record and pause buttons), while data from a capture buffer is uploaded from the controller in a single operation.

- To connect to the controller
  - Select the Online button on the Trender toolbar. (If any of the source controllers are redundant controllers, the Trender prompts you to select a redundant channel before opening the connection.)

- To begin capturing a trend from live traces
  - On the Data toolbar, select the Record Data button. The Trender switches to Live mode, and the Graph View continuously scrolls the time axis to display the latest incoming data while recording.

- To freeze the display while capturing a trend from live traces
  - On the Data toolbar, select the Pause button. Data continues to be collected but the Trender switches to Replay mode until the Pause button is selected again.

- To stop capturing a trend from live traces
  - On the Data toolbar, select the Record Data button. The Trender returns to Replay mode.

- To retrieve data from a capture buffer
  - On the Data toolbar, select the Upload button.
**Trender Concepts**

### Chapters

When working with live, or capture buffer, or some historical sources, the Trender can record more than one set of data. The basic unit of data capture in the Trender is a chapter. A chapter represents one acquisition session, which is either a single upload for a capture buffer source or a single period between clicks of the Record Data button for a live source. Chapters are organized chronologically, so the first acquisition session is always the first chapter and the most recent session is always the last chapter.

A Trender window only displays one chapter of information at a time. Each chapter maintains its own traces and events. The Events tab only displays events applicable to the currently displayed data. Similarly, the user data field is unique to each chapter, so comments about a data set are stored alongside each chapter.

- **To navigate between Chapters**

  - Click the Previous Chapter or Next Chapter button on the Data toolbar. (If these options are disabled, there are no other chapters available.)

### Cursors

In Replay Mode in the Graph View, two cursors individually select values of time and together select ranges of time. The cursors are used by a number of functions in the Trender, such as trace statistics, user events, and data export. The time represented by each cursor is displayed in the status bar at the bottom of the Trender.

1. **To select a range of time**
   1. Place the mouse pointer over the diamond at the top of a cursor and drag the diamond to the desired left boundary location.
   2. Place the mouse pointer over the diamond at the top of the other cursor and drag the diamond to the desired right boundary location.

2. **To select a single time**
   1. Place the mouse pointer over the diamond at the top of a cursor and drag the diamond to the desired value.
   2. If the diamond for the cursor that represents the time value you wish to select is not colored white, click the diamond to select it as the active cursor.
When selecting a range of values, there is no left or right cursor – you may arrange the cursors in whichever way is most convenient. The Trender automatically identifies the leftmost and rightmost cursors.

While there are always two cursors on the Graph View, it may appear that there is only one cursor on the Graph View if both cursors are set to the same time value.

**Value ScreenTips**

If you place the mouse pointer over an axis or a trace in the Graph View, the Trender displays the exact value in a ScreenTip. The ScreenTip remains as long as the pointer is over the selected item.

**Events**

During real time monitoring of the controller, certain events may occur such as alarms and diagnostics. As these events occur, they display in the Trender as a small triangle on the time axis. All events in the current Chapter appear on the Events tab, which displays the time and description of each event.

- **To jump to an event**
  - From the Event tab, double-click on the description of the desired event.

In addition to events added by the controller, you can add your own User Events. If added during Live mode, the User Event is placed at the time of the most recently received sample at the instant the Add User Event command is selected. During Replay mode, new User Events are added at the time indicated by the active cursor. (Refer to the section, Cursors.)

- **To add a user event**
  1. Select an active cursor.
  2. From the Edit menu, select Add User Event. (Or, press the shortcut keys CTRL+M.)
  3. Enter a name for the new event, and select OK.
Working With Trender Data

Graph View Options

The Graph View can display data on either a single graph or a set of stacked graphs. Single Trace mode displays all traces on the same graph, while Stacked Trace mode displays each trace on an individual graph. In both modes, all traces share the same time axis, but each trace maintains its own vertical axis. (If there are too many traces to display stacked graphs effectively in the available space, the Trender may revert to Single Trace mode even if you have selected Stacked Trace mode.)

Note In Single Graph mode, the vertical axis markings correspond to the trace listed first on the Trace Tab. Each trace is drawn according to its own scale and, as such, traces other than the first trace may not correspond to the displayed axis markings.

Stacked Trace Mode, Single Trace Mode

➢ To turn Stacked Trace mode on or off
◆ From the View menu, select Stacked Traces.
**Grid Lines**

The Trender can display grid lines that correspond to major axis divisions on the Graph View. These lines, which only display when the Trender is in Replay mode, can be useful when the exact trace values are important.

![Grid Lines On, Grid Lines Off](image)

- **To enable or disable grid lines**
  1. From the **Options** menu, select **Settings**. The **System Options** dialog box displays with **Trender** selected in the **Tree View**.
  2. From the **Property Editor**, locate the category **Grid Lines** and set the values for **Horizontal** and **Vertical** to either True or False.
  3. Click **OK** to close the **Settings** dialog box.

**Sample Markers**

When exact values at each sample reading are important, the Trender can display Sample Markers at each sample collection point. By default, Sample Markers display when the current Graph View contains ten or fewer samples. If desired, you can change the Sample Marker threshold.

![Sample Markers](image)

- **To set the Sample Marker threshold**
  1. From the **Options** menu, select **Settings**. The **System Options** dialog box displays with Trender selected in the **Tree View**.
  2. In the **Property Editor**, under the category **General**, enter a new value for **Sample Markers**.
  3. Click **OK** to close the **Settings** dialog box.
**Time Axis**

The Time Axis controls the range of samples that display in the Graph View. All traces share a single Time Axis, even when Stacked Trace Mode is enabled.

- **To change the range displayed on the Time Axis**
  - Click the **Reverse** or **Forward** buttons on the Data toolbar.

- **To display a shorter or longer period of time on the Time Axis**
  - Click the **Zoom In** (to reduce the duration) or **Zoom Out** (to increase the duration) buttons on the Data toolbar / Click on the time axis and edit the **Duration** property in the Property Editor.

The Zoom In and Zoom Out commands behave differently depending on the current mode. In Live mode, the Zoom In command sets the duration to one third of the current value and the Zoom Out command sets the duration to three times the current value. In Replay mode, the Zoom Out command still sets the duration to three times the current value, but the Zoom In command sets the duration to the exact region selected by the two cursors. (For more information on selecting a range, refer to the section, *Cursors.*)

---

**Tip**

To quickly change the range of an axis, you can click any point on the axis and drag it to a new location. This operation works for both the value and time axes and is frequently the most effective way to change the displayed set of data.

---

**Traces**

The Trender window maintains separate settings for each trace. These settings, which include trace color, sample capacity, and pen width, are accessed through the Property Editor when a trace is selected on the Trace tab. In addition, Value (vertical) Axis settings managed through each trace allow an appropriate scale and range to be determined for each item.

**Auto-range Trace**

To display a set of collected samples in the Graph View, an appropriate Value Axis scale and range must be selected. For most data sets, an optimal scale and range would display all collected samples in the selected time range with minimal wasted space. The Auto-Range Trace feature sets the range of the Value Axis for the currently selected trace(s) to the optimal values. Even if you decide to further refine the range of the trace, the Auto-Range Trace feature provides a convenient starting point.

- **To auto-range a trace**
  - From the Traces tab, select one or more traces, then select the **Auto-Range Selected Traces** button on the Data toolbar.
**Manual Range Adjustment**

When the Auto-Range Trace feature selects an inappropriate range, or if you want precise control over the range, you can provide a minimum and maximum value for the Value (vertical) Axis.

- **To manually adjust the range for a trace**
  
  * From the **Traces** tab, select one or more traces, then adjust the **Bottom Value** and **Top Value** properties under **Range** in the **Property Editor**.

**Trace Colors**

The Trender assigns each new trace a color from a set of eight colors stored in the Settings window. After eight traces are created, these colors are reused. You may wish to change the color of a trace, especially when multiple traces display on a single graph.

- **To change the color assigned to a trace**

  1. From the **Traces** tab, select a trace.
  2. In the **Property Editor**, locate the **Pen** category and select the **Color** property.
  3. Click the drop-down list and select the **Custom** (for a color palette) or **Web** (for a list of named colors) tab.
  4. Click the square that corresponds to the desired trace color. The trace updates automatically.

- **To modify the default trace colors**

  1. From the **Options** menu, select **Settings**.
  2. Locate and select the **Trender** item in the **Settings** window.
  3. In the **Property Editor**, select the number of the trace (for example, 2nd Trace) to be changed.
  4. Click the drop-down list and select the **Custom** (for a color palette) or **Web** (for a list of named colors) tab.
  5. Click the square that corresponds to the desired trace color.
  6. When you have finished changing trace colors, click **OK**.
Hiding Traces

In some situations, especially with capture buffers, a Trender window contains more traces than you want to monitor at a particular time. Traces in a Trender window can be hidden. They still collect data, but they do not display in the Graph View or the Trace tab.

➢ To hide traces

1. From the Traces tab, select one or more traces.

2. From the Edit menu, select Hide Selected Traces, or right-click on the selected traces and select Hide Selected from the context menu.

-or-

Select the check box next to the variable name in the Traces tab or the Auxiliary View to hide or show the trace on the graph.

➢ To show or hide a trace

♦ From the Edit menu, select Show Traces. Select and clear the check boxes next to the trace names as desired, then click OK.

-or-

Select the check box next to the variable name in the Traces tab or the Auxiliary View to hide or show the trace on the graph.
Statistical Calculations

The Trender can calculate a set of basic one variable descriptive statistics for collected data while in the Replay mode. These statistics, which are calculated only on data in the time range selected by the two cursors, include average, standard deviation, minimum, maximum, and difference (calculated as final – initial). The calculated values display as columns on the Trend tab when enabled.

To display statistical calculations
1. From the Options menu, select Settings.
2. Locate and expand the Trender item in the Settings window. Under the Trender item, select Replay Columns.
3. In the Available list, select one or more columns to enable. (To make multiple selections, hold down the CTRL key while selecting additional items.)
4. Click the Add button to move the statistics to the Selected list.
5. When you have finished enabling statistics, select OK.
**Exchanging Trender Data**

**Exporting to a File**

The Trender can export all traces contained in a Trender window to a file for external analysis. This file can be imported into third-party applications or exchanged with other users. All traces, including ones currently hidden, are exported.

- **To export all traces to a file**
  1. From the **File** menu, select **Export Data**.
  2. In the **Trender Export Data Options** box, adjust options as desired to produce a file compatible with your desired format. The default options produce a standard .csv file. (See below for a description of each option.)
  3. Select OK when you have finished selecting options. A **Save** dialog box displays.
  4. Select a location for the exported file and click **OK**.

![Trender Export Data Options](image)

- **Controls whether the first line of the exported file contains header information for each column.**
- **Controls whether a column containing timestamps is added to the output.**
- **Controls whether a column containing increasing integers is added to the output.**
- **If selected, only the time range selected by the cursors is exported.**
- **Controls the character used to separate values in the exported file.**
- **Controls the text exported when no data is available for a trace at a given point in time.**
- **Selects the precision of the exported timestamp.**

**Printing Graphs**

The Trender can print the currently displayed graph to any printer attached to the system. Printed graphs reflect the current appearance of the Graph View, including displayed traces, colors, and axis boundaries.

- **To preview the results of a print command**
  ♦ From the **File** menu, select **Print Preview**.

- **To print the current Graph View**
  ♦ From the **File** menu, select **Print**. Adjust printing options as desired and click **OK**.
Spectral Analysis

The Trender provides the ability to perform a spectral analysis on a dataset.

- To perform a spectral analysis

- From the View menu, select Spectral Analysis.

A digital spectrum analysis of a waveform changes this time domain data into frequency domain data, also called a frequency spectrum of the dataset. This is also referred to as a Fast Fourier Transform (FFT).

The effect of an FFT on a sample dataset is shown below. The first is an input dataset showing actual generator speed (RPM) and PWA accelerometer Y/Z direction data (force in Gs).

Note The spectral analysis of this data is able to quickly isolate the most common frequencies at which this data is varying.
In the example above, analyzing the input waveform (top) produces the frequency spectrum below it, where three distinct groupings display at frequencies centered on 0.1, 0.35, and 0.9.
**FFT Options**

The Fast Fourier Transform (FFT), activated by the Spectral Analysis option, is configurable.

- **To access FFT settings**

  ![Trender Settings dialog box](image)

  Click the Trender Properties icon. The Trender Settings dialog box displays.

FFT options include the following:

- **Between Cursors**, if set to True, applies an FFT between the left and right cursors that can be positioned inside the graphics window.

- **Padding Factor** provides a way to interpolate between real points with copies of the same data, which enhances the spectrum resolution.

- **Remove Mean**, if set to True, improves the ability to scale the data for visualization.

- **Windowing Mode** affects the equations used by the FFT. The following windowing modes are available:
  - Hann
  - Hamming
  - Barlett
  - Welch
Chapter 10 EGD Editor for External Devices

The EGD Component Editor for external devices allows you to configure Ethernet Global Data (EGD) for an external or third-party device. The EGD protocol allows controller devices (sometimes known as nodes) to share information in a networked environment. EGD allows one controller device, referred to as the producer of the data, to simultaneously send information to any number of peer controller devices (consumers) at a fixed periodic rate. This network supports a large number of controller devices capable of both producing and consuming.

Network Adapters

The General tab configures Ethernet adapters for an external EGD-capable device. One adapter is created by default, and up to four adapters can be added.

➢ To add a network adapter

1. From the System Editor, right-click an external device, then select Edit EGD. (If Edit EGD is not available, the EGD Editor Enable property of the component may be set to False. The EGD Component Editor opens.)
2. From the Component Editor, select the General tab.
3. From the Tree View, right-click the Network Adapters item, then select Add Adapter.

➢ To remove a network adapter

1. From the System Editor, right-click an external device, then select Edit EGD. (If Edit EGD is not available, the EGD Editor Enable property of the component may be set to False. The EGD Component Editor opens.)
2. From the Component Editor, select the General tab.
3. From the Tree View, right-click the network adapter to be removed, then select Delete Adapter.
The following properties are available for configuration when a Network Adapter is selected in the Tree View:

![Network Adapter Tree View]

Configuration options for the Network Adapter are as follows:

<table>
<thead>
<tr>
<th>Adapter Settings Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host Name</td>
<td>This is the Internet Protocol (IP) host name for the selected network adapter.</td>
</tr>
<tr>
<td>IP Address</td>
<td>This is the IP address for the selected network adapter.</td>
</tr>
<tr>
<td>Wire Speed</td>
<td>This is the speed of the connected network.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Network Settings Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Name</td>
<td>This is the name of the connected network.</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>This is the subnet mask associated with the connected network.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Network Switch Connection Settings Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Switch</td>
<td>This is the network switch the network adapter is attached to.</td>
</tr>
<tr>
<td>Port Number</td>
<td>This is the network switch port the network adapter is attached to.</td>
</tr>
</tbody>
</table>
To configure EGD for an external device

1. From the System Editor, right-click an external device component and select Edit EGD. (If Edit EGD is not available, the EGD Editor Enable property of the component may be set to False. The EGD Component Editor opens.)

2. From the Component Editor, select the EGD tab.

3. In the Tree View, select Ethernet Global Data. The Ethernet Global Data properties display in the Property Editor.

These properties are available for configuration when Ethernet Global Data is selected in the Tree View:

- **Collection** controls the Collection to which this EGD component belongs when viewed in the EMT tool. This information is published to the EGD Configuration server in the GUI component document, GUIDevice.xml.

- **Producer ID** sets and displays the EGD Producer ID for this component. This is assigned when the component is created. The Property Editor displays the EGD Producer ID formatted as an unsigned integer, but dotted and hexadecimal representations are available by clicking the ellipsis button.
Produced Pages

Produced Pages are data sets configured to be available to other components on the network.

- **To add a new Produced Page**
  1. From the Tree View, right-click the Produced Pages item, then select Add Page.
  2. Enter a unique name for the new page in the Page Name dialog box, then click OK.

- **To delete a Produced Page**
  - From the Tree View, right-click the page you wish to delete, then select Delete.

**Editing Produced Pages**

- **To configure a Produced Page**
  - From the Tree View, select the EGD tab, then expand the Produced Pages.

From the Tree View, select the desired page.
The page properties display in the Property Editor.

The page properties display in the Property Editor.

- **Destination**
  - **Destination IP Address**: 0.0.0.0
  - **Mode**: Multicast

- **General**
  - **Exchanges**: 1

- **Setup**
  - **Layout Mode**: Auto
  - **Name**: Status
  - **Period**: 1000
  - **Skew**: 0
  - **Starting Exchange ID**: 1

Destination IP Address
The IP address to which the exchanges on this page are Unicast or Multicast to.
The following properties are available for configuration when a Produced Page is selected in the Tree View:

<table>
<thead>
<tr>
<th>Destination Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination IP Address</td>
<td>This sets the IP address to which the exchanges on this page are unicast or multicast. (If the Mode property is set to Broadcast, this property is not available.)</td>
</tr>
<tr>
<td>Ethernet 0</td>
<td>If set to True, EGD is broadcast on Ethernet 0. (If more than one Ethernet Adapter has been configured for EGD, additional Ethernet properties display.)</td>
</tr>
<tr>
<td>Mode</td>
<td>This can be set to Broadcast, Unicast, or Multicast, depending on the modes supported by the component’s EGD implementation profile.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Broadcast</strong> sends the page to all EGD components.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Unicast</strong> sends the page to a single destination.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Multicast</strong> sends the page to the specified multicast addresses.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>General Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exchanges</td>
<td>This indicates the number of exchanges in the selected page. It is updated after selecting the Build command.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Setup Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout Mode</td>
<td>This determines whether the exchange numbers and offsets are assigned automatically at build time or are entered manually.</td>
</tr>
<tr>
<td>Name</td>
<td>Use this property to rename the selected page.</td>
</tr>
<tr>
<td>Period</td>
<td>This is the transmission period of the page in milliseconds.</td>
</tr>
<tr>
<td>Skew</td>
<td>This is used to prevent exchanges with the same period from being produced at exactly the same instant. The skew for the first exchange in the page is set to this value, and each additional exchange skew differs from the previous exchange’s skew by exactly this value (in nanoseconds). For example, if you have three exchanges in a page and a skew value of 2, the first exchange’s skew is two, the second exchange’s skew is four and the third exchange’s skew is six.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> The Skew property will not be visible if it is not supported in the implementation profile configuration.</td>
</tr>
<tr>
<td>Starting Exchange ID</td>
<td>This sets the Exchange ID used for this page. Each additional exchange will be incremented from the number.</td>
</tr>
</tbody>
</table>
Page Compression

When a page compression is performed, the variables are located in increasing size order, starting with Booleans, then Words, Double Words, and finally all other variables. A page compression causes an exchange major signature. Consumers can mark the exchange variables as unhealthy until the consumed configuration can be rebound.

➢ To compress a single page

♦ From the Tree View, right-click the page to compress, and then select Compress.

➢ To compress all Produced Pages in a component

♦ From the Tree View, right-click Produced Pages, and then select Compress All.
Variables

➢ To add a variable to a produced page

♦ From the Tree View, select a Produced Page to display a Data Grid in the Summary View.

To delete a variable from an EGD Page

♦ From the Summary View, right-click the variable to delete, and then select Delete Selected Row(s).

➢ To copy variable information from an EGD page to the clipboard

♦ From the Summary View, right-click a variable, and then select Copy Selection. The data is copied in .csv format.
**Editing Exchange Signatures and Configuration Time**

Normally, the exchange signature is managed automatically. The major signature must be incremented when the exchange content changes in any way other than additions to the end. If you are using the EGD Device Editor to configure EGD for a device and the device signature changes only when the manufacturer updates the configuration, you may need to manually set the signature.

*Note*  To edit exchange signatures and configuration time, set Layout Mode to Manual.

- **To edit exchange signatures and configuration time**

1. From the EGD tab, select the Configuration tab, then select a Produced Page in the Tree View.

2. Right-click an exchange in the Summary View, then select **Edit Exchange Signatures and Configuration Time**.

3. Review the warning about manual Exchange Signature editing, then click **OK**.

4. Make any desired changes to the signatures and configuration time, then click **OK** to close the dialog box.
Referenced Devices

The EGD variables defined in other components can be added to the current component’s variable list by adding a reference. References can only be created to EGD-capable devices that are consumers of Produced Pages, and as such only EGD-capable devices are available for referencing.

➢ To select referenced devices

♦ From the Tree View, right-click the Referenced Devices item, and then select Select Devices to display the Select Devices dialog box.

The EGD configuration for the selected devices is loaded and the variables display in the Summary View.

When EGD configurations are edited in remote devices, you must refresh the configuration periodically to ensure that the latest variable information is used. This is automatically done during a Bind and Build operation as well as when a configuration is saved.

➢ To refresh the configuration of a referenced device

♦ In the Tree View, right-click the device to be refreshed, and then select Refresh.
Implementation Profile

Each EGD node type has a set of supported EGD features. For example, a device might have an EGD implementation that only supports broadcast-produced data. The implementation profile contains details about the EGD implementation of a particular device.

The following properties are available when editing an Implementation Profile:

<table>
<thead>
<tr>
<th>Configuration Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Support</td>
<td>Allows you to edit various configuration features as follows:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Accepts Deletes</strong> indicates device support for HTTP deletes.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Accepts Puts</strong> indicates device support for HTTP Put commands.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Multiple Producer IDs</strong> indicates device support for multiple producer IDs.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Zip Content</strong> indicates device support for zipped transfers.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Types</td>
<td>This allows you to configure supported data types. (Clicking the ellipsis button opens an editor window.)</td>
</tr>
<tr>
<td>Double Word Alignment</td>
<td>The offset of a DWORD length variable must be evenly divisible by this number.</td>
</tr>
<tr>
<td>Word Alignment</td>
<td>This is set to True if the component requires that all WORD length variables be aligned on an even boundary.</td>
</tr>
<tr>
<td>Feature Support Category</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Broadcast</td>
<td>This is set to True if the component supports broadcast destinations for EGD data or command packets and False otherwise.</td>
</tr>
<tr>
<td>Masked Write</td>
<td>This is set to True if the component supports the MaskedWrite command and False otherwise.</td>
</tr>
<tr>
<td>Max Coherent Data</td>
<td>This returns the maximum size (in bytes) of a variable that still is guaranteed coherent transfer. If the attribute is not present, then all data is guaranteed coherent transfer regardless of size. It is optional and is initialized to 0.</td>
</tr>
<tr>
<td>Max Exchanges</td>
<td>This returns the maximum number of exchanges supported by the device. It is optional and is initialized to 0.</td>
</tr>
<tr>
<td>Max String</td>
<td>This returns the maximum size string supported by the component. If the attribute is not present, then the component has no set maximum size for strings. It is optional and is initialized to 0.</td>
</tr>
<tr>
<td>Multicast</td>
<td>This is set to True if the component supports multicast destinations for EGD data or command packets and False otherwise.</td>
</tr>
<tr>
<td>Skew</td>
<td>This is a Boolean value representing the capability of the producer to support the skewing of produced exchanges with respect to time.</td>
</tr>
<tr>
<td>Unicast</td>
<td>This is a Boolean value that is set to True if the component supports unicast destinations for EGD data or command packets. Otherwise, it is set to False.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>General Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Class</td>
<td>This is the class of the device as defined in the EGD Protocol Specification:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Supports only the configuration port.</td>
</tr>
<tr>
<td>1</td>
<td>Supports the data port and the Data Production PDU.</td>
</tr>
<tr>
<td>2</td>
<td>Supports all class 1 services, plus at least acts as a responder for the command port, and the commands associated with that port.</td>
</tr>
<tr>
<td>3</td>
<td>Supports all class 2 services, plus the configuration port, and the required commands associated with that port. Such devices support responding to configuration requests but do not dynamically bind their consumed variables.</td>
</tr>
<tr>
<td>4</td>
<td>Supports all class 3 services, plus dynamically binding consumed variables.</td>
</tr>
</tbody>
</table>

| Device Name | This is the name of the class of device to which this device belongs |
Viewing Live Data Values

The EGD specification defines a Command Message Protocol (CMP), which allows for reading and writing values. It allows you to obtain statistical and configuration information from an EGD device. The EGD device must be Class 2 or greater for CMP support.

The generic editor uses CMP to display live data values on a produced or referenced device summary grid view. The Connection Toolbar button sends the CMP message to the device to obtain the data.

Once connected, the **Produced Pages** or **Referenced Devices** option displays the values. Use the **Refresh** button in the column header to update the grid.

<table>
<thead>
<tr>
<th>Refresh</th>
<th>Name</th>
<th>Description</th>
<th>Type</th>
<th>Access</th>
<th>Array</th>
<th>Units</th>
<th>Ex</th>
</tr>
</thead>
<tbody>
<tr>
<td>17999.5</td>
<td>SAW</td>
<td>Saw tooth output 00</td>
<td>REAL</td>
<td>ReadOnly</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>17999.5</td>
<td>SAWTOOTH00</td>
<td>Saw tooth output 00</td>
<td>REAL</td>
<td>ReadOnly</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>32681.654</td>
<td>SAWTOOTH01</td>
<td>Saw tooth output 01</td>
<td>REAL</td>
<td>ReadOnly</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>42273.25</td>
<td>SAWTOOTH02</td>
<td>Saw tooth output 02</td>
<td>REAL</td>
<td>ReadOnly</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>274.54596</td>
<td>SAWTOOTH03</td>
<td>Saw tooth output 03</td>
<td>REAL</td>
<td>ReadOnly</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>26469.58</td>
<td>SAWTOOTH04</td>
<td>Saw tooth output 04</td>
<td>REAL</td>
<td>ReadOnly</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>35969.617</td>
<td>SAWTOOTH05</td>
<td>Saw tooth output 05</td>
<td>REAL</td>
<td>ReadOnly</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>878.54388</td>
<td>SAWTOOTH06</td>
<td>Saw tooth output 06</td>
<td>REAL</td>
<td>ReadOnly</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>9002.2363</td>
<td>SAWTOOTH07</td>
<td>Saw tooth output 07</td>
<td>REAL</td>
<td>ReadOnly</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>18770.211</td>
<td>SAWTOOTH08</td>
<td>Saw tooth output 08</td>
<td>REAL</td>
<td>ReadOnly</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>44512.598</td>
<td>SAWTOOTH09</td>
<td>Saw tooth output 09</td>
<td>REAL</td>
<td>ReadOnly</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>4243.6152</td>
<td>SAWTOOTH10</td>
<td>Saw tooth output 10</td>
<td>REAL</td>
<td>ReadOnly</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>12367.702</td>
<td>SAWTOOTH11</td>
<td>Saw tooth output 11</td>
<td>REAL</td>
<td>ReadOnly</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>27460.429</td>
<td>SAWTOOTH12</td>
<td>Saw tooth output 12</td>
<td>REAL</td>
<td>ReadOnly</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>37198.457</td>
<td>SAWTOOTH13</td>
<td>Saw tooth output 13</td>
<td>REAL</td>
<td>ReadOnly</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>12354.141</td>
<td>SAWTOOTH14</td>
<td>Saw tooth output 14</td>
<td>REAL</td>
<td>ReadOnly</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>22661.021</td>
<td>SAWTOOTH15</td>
<td>Saw tooth output 15</td>
<td>REAL</td>
<td>ReadOnly</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>30769.93</td>
<td>SAWTOOTH16</td>
<td>Saw tooth output 16</td>
<td>REAL</td>
<td>ReadOnly</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>45765.203</td>
<td>SAWTOOTH17</td>
<td>Saw tooth output 17</td>
<td>REAL</td>
<td>ReadOnly</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>5175.0054</td>
<td>SAWTOOTH18</td>
<td>Saw tooth output 18</td>
<td>REAL</td>
<td>ReadOnly</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>31272.121</td>
<td>SAWTOOTH19</td>
<td>Saw tooth output 19</td>
<td>REAL</td>
<td>ReadOnly</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>33357.308</td>
<td>SAWTOOTH20</td>
<td>Saw tooth output 20</td>
<td>REAL</td>
<td>ReadOnly</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>
**EGD Diagnostics**

A CMP can be used to obtain the status of a Class 2 or higher EGD device. When any EGD tree node other than a Referenced Device is selected, the EGD Statistics from [Device] tab displays the statistics from the open component. When a Referenced Device tree node is selected, statistics are obtained from that referenced device, and the name of the tab page changes accordingly.

**Exchange** is the Exchange identifier: `<device name>.<exchange number>`

**Configuration Time** is the time that the exchange was configured.

**Due Time** is the time that a consumer data packet must be received for an exchange to remain valid.

**Status** is the health of the exchange.
**Length** is the value for a produced exchange. This length may be the highest variable offset in the exchange or the highest offset of a variable, which may have been removed. For a consumed exchange, the value may be the highest variable offset used or the length of the produced exchange, depending on the bind algorithm of the individual tool.

**Message Count** is the number of data production packets produced or consumed since initialization.

**Missed Count** is the number of data production packets missed since initialization. A missed packet occurs when a data production message is received that has a request ID greater by more than one than the last message received (accounting for counter roll-over).

**Refresh Errors** are the number of times a refreshment fault has occurred. A refreshment fault occurs when a subsequent data production packet (or initial packet at startup time) does not arrive at a consumer within a pre-defined update period.
The EGD Configuration Server tab in the Summary View allows you to view and delete EGD nodes currently residing in the configuration server. The configuration server used is the one defined in the System Editor in the Tree View. If the server is enabled, this tab displays information from that server.

**Note** The EMT provides a detailed view of the configuration server contents.

<table>
<thead>
<tr>
<th>Configuration</th>
<th>EGD Statistics from G1</th>
<th>EGD Configuration Server</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The tab control contains a toolbar with two buttons:

- **Filter Toggle button** defaults to a filtered state. It displays items that have the same name but have a different Producer ID as the open component.

- **Delete button** deletes the selected item(s). If the item(s) were saved as part of the configuration, they can be added again.

The EGD configuration server uses the producer ID to store all the documents for an EGD node.

**Note** A system can have one EGD Configuration Server only.

If you open two systems, then point to the same configuration server and save a device of the same name with two different producer IDs to that server, you can end up with two producer ID nodes with the same device name.
# External Device Menus

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Use to</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td>Save</td>
<td>Update the EGD configuration files, refreshes consumed exchanges and variables, assigns produced variables to exchanges, and, if an EGD configuration server has been specified, publishes the configuration to the server</td>
</tr>
<tr>
<td></td>
<td>Import and Export</td>
<td>Transfer produced data, consumed data, symbols, implementation profiles, and GUI device EGD configuration files to and from a variety of file formats</td>
</tr>
<tr>
<td></td>
<td>Print</td>
<td>Print the summary grid view with the column selection, order, and width currently visible in the view</td>
</tr>
<tr>
<td></td>
<td>Close</td>
<td>Close the currently opened device</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>Undo</td>
<td>Remove the item currently selected in the Tree View</td>
</tr>
<tr>
<td></td>
<td>Redo</td>
<td>Add a new component to the current system</td>
</tr>
<tr>
<td></td>
<td>Cut</td>
<td>Cut the selected item in the Tree View</td>
</tr>
<tr>
<td></td>
<td>Copy</td>
<td>Copy the selected item in the Tree View</td>
</tr>
<tr>
<td></td>
<td>Paste</td>
<td>Paste the copied item in the Tree View into the Summary View</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>Display the System Information Editor (refer to the section System Information Editor)</td>
</tr>
<tr>
<td></td>
<td>Find</td>
<td>Display the Component Editor for the item currently selected in the Tree View</td>
</tr>
<tr>
<td><strong>View</strong></td>
<td>Go Forward</td>
<td>Return to the view that immediately follows the current view in the history.</td>
</tr>
<tr>
<td></td>
<td>EGD Management Tool</td>
<td>Open the EGD Management Tool screen.</td>
</tr>
<tr>
<td><strong>Device</strong></td>
<td>Online</td>
<td>Send CMP messages to EGD Class 2 or higher devices to view live values from the device.</td>
</tr>
<tr>
<td></td>
<td>Bind and Build</td>
<td>Refresh the consumed information for all referenced devices, automatically sets the layout of any unassigned produced variables, and, if no errors occur, publishes the configuration to the EGD configuration server.</td>
</tr>
<tr>
<td></td>
<td>Put Device to SDB</td>
<td>Store the current EGD configuration to the System Database (SDB). It is only available if the system has an SDB enabled and configured.</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>Release Notes</td>
<td>Display the release notes for the current version of the application.</td>
</tr>
<tr>
<td></td>
<td>About</td>
<td>Display version and copyright information about the application.</td>
</tr>
</tbody>
</table>
Chapter 11 Configuration Management System (CMS)

The ControlST software suite includes a Configuration Management System (CMS), which provides revision control and history tracking for ToolboxST systems. It consists of three components:

- **CMS server**
- **Stand-alone Client** is accessed through the Start menu
- **Integrated Client** is accessed through the ToolboxST* application

**CMS Server**
- The CMS Server software manages and tracks configuration changes on a ToolboxST system

**CMS Repository**
- System(s) under CMS control
- History of changes
- Backup and Restore feature

**CMS Users**
- Database of CMS users associated with a repository
- Validates CMS clients to permit access to repository

**CMS Stand-alone Client**
- Separate application accessed from Start menu

**CMS Integrated Client**
- Accessed from within ToolboxST application

**CMS Client Functions**
- Login to CMS Server
- Update CMS status in client
- Add ToolboxST system
- Get Latest Version
- Check Out/Check in
- Show History/Difference
The CMS server application performs the following functions:

- Establishes a security model for the server. CMS security uses Windows (Domain or Workgroup) security for user authentication (CMS users must exist as valid domain or workgroup users).
- Creates (or deletes) a master location, called the repository. The repository is a place where configuration files are stored and maintained. All change revision history is maintained in the repository.
- Adds (or deletes) CMS user names and privileges to control access to the systems in the repository.
- Provides a mechanism to Backup and Restore the Repository. The backups include revision history for all the ToolboxST systems in that repository. User information for the repository can also be included or excluded from the backup copy.
- Starts and stops the CMS server application.

The CMS client applications (Stand-alone and Integrated) perform the following functions:

- Log on to the CMS server to use CMS.
- Establish a Working folder for each CMS user. A copy of the configuration file from the repository is placed in the user’s working folder.
- Add a configuration file to the repository, which enables revision tracking on the system.
- Update the current CMS status for all components in a system in the user’s working folder as compared to the system in the repository. Icons in the CMS client indicate equal, old, missing, or checked out (for example, by User xyz on computer name).
- Get a copy of the latest version of the configuration file from the repository. This copies the latest system from repository to the user’s working folder.
- Check out a configuration file and/or component from the repository to make changes. Changes are made to the system in the user’s working folder.
- Check in the configuration file and/or component into the repository. The user can add a change description for each component during check in. Changes and comments are recorded in the repository with a revision number.
- Show a history of all changes for a configuration file or component.
- Show the difference between the configuration file or component in the user’s working folder and the latest copy in the repository.
- Get an earlier version of the configuration file or component.
Installing the CMS Server

A CMS server must be installed separately on a single master computer and configured for a specific site. A user must have administrator privileges to control access to the systems and perform certain tasks.

The CMS server uses a repository to track system changes, and to control client access. Each repository contains a list of CMS users and permissions for the repository. The repository maintains the revision change history for ToolboxST systems that are added to the repository. A CMS server can have one or more repositories, and each repository can contain one or more ToolboxST systems.

➢ To install the CMS server

1. Place the CD in the CD-ROM drive. The installation starts automatically. The Setup dialog box displays.

2. The Welcome dialog box displays. Click Next. The License Agreement dialog box displays.

3. To continue the installation, you must accept this agreement. Select Agree.
4. Click **Next**. The **User Information** dialog box displays.

5. Click **Next**. The **Destination Folder** dialog box displays. If this is the first time the ToolboxST application has been installed on this computer, the Browse button allows you to change the default install location (C:\Program Files\GE Energy\). If this is a subsequent installation, this dialog box displays where this version of the product is installed.

6. Continue to click the **Next** until the installation starts. Click **Finish** when the installation has completed successfully.

---

**Attention**

For the CMS server to work correctly, the Use Simple File Sharing option check box must be cleared.

Right click **Start** and select **Explore**.

From the **Tools** menu, select **Folder Options** to display the **Folder Options** dialog box.

From the **Advanced settings**, clear the **Use simple file sharing** check box and click **OK**.

---
Creating Windows User Accounts

**Note** You must have administrator privileges to create user accounts on the server computer.

CMS uses Windows security (domain or workgroup) for authentication. All CMS user names must exist in Windows (domain or workgroup) before they can be added in the CMS server.

For workgroup security, the CMS user names only need to be added as Windows users on the CMS server computer (users do not need to be added on all CMS client computers).

For domain security, the CMS user names must be added by the domain administrator if they do not exist.

➢ To create users in Windows

1. From the **Start** menu, select **Control Panel, Administrative Tools**, and **Computer Management**. The **Computer Management** screen displays.

![Computer Management](image)

From the tree view, select **Local Users and Groups**. Right-click **Users** and select **New User...**
2. The **New User** dialog box displays.

Enter the **User name**. Enter an optional **Full name** and **Description**, if desired.

Enter a **Password**, then re-enter it to confirm.

Select any of these options, if necessary, then click the **Create** button.

---

**Note** When creating accounts specifically for CMS use in a workgroup, select the options **User cannot change password**, and **Password never expires**.
➢ **To make the new user an administrator**

1. From the **Computer Management** screen, right-click the new user and select **Properties**. The **Properties** dialog box displays.

Select the **Member Of** tab.

Select the **Administrators** group and click **Apply** and **OK**.

If the **Members Of** tab is blank, click the **Add** button.

The **Select Groups** dialog box displays.

Click the **Advanced** button to select the **Administrators** group.
Click the Find Now button to display available groups.

Select Administrators then click OK.

The dialog box closes and the previous Select Groups dialog box displays again, with the Administrators group displayed in the object name text box.

2. Click OK. The User Properties dialog box displays again with the Member Of tab selected.

3. From the Member Of tab, select the Administrators group, click Apply and OK.
## Configuring the CMS Server

The CMS administrator tool is installed with the CMS server. The tool allows you to perform administrator tasks on the server as follows:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Use to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repository</td>
<td>Select</td>
<td>Select a repository to store and maintain files.</td>
</tr>
<tr>
<td></td>
<td>Create</td>
<td>Create a new repository.</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>Delete an existing repository. It is a good idea to back up the repository before deleting it.</td>
</tr>
<tr>
<td></td>
<td>Backup</td>
<td>Create a copy of the repository.</td>
</tr>
<tr>
<td></td>
<td>Restore</td>
<td>Restore a repository from a backup copy.</td>
</tr>
<tr>
<td>Users</td>
<td>Add</td>
<td>Add a new user. Enter the user ID and configure Permissions. If you select <em>User can modify system</em>, that user cannot access the CMS Administrator.</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>Remove a user from the system.</td>
</tr>
<tr>
<td></td>
<td>Edit</td>
<td>Edit permissions for a particular user.</td>
</tr>
<tr>
<td>Tools</td>
<td>Server</td>
<td>Start and stop the server.</td>
</tr>
<tr>
<td></td>
<td>Settings</td>
<td>Select the User Type depending on the Windows security model for your site. Changing this option will delete all repositories on the server. You will be prompted to backup all repositories.</td>
</tr>
</tbody>
</table>

**Note:** Stopping the server disables all repository operations.

**Note:** If you select Domain Users you must know the Administrator domain name and password.
Accessing the Administrator Tool

To access the Administrator Tool

1. From the Start menu, select All Programs, GE Control ST, and CMS Server. Click Administrator Tool.

When the CMS Administrator Tool is started for the first time, the CMS Settings dialog box displays.

Note To run the Administrator Tool and log in, you must have administrative permissions on your computer. The first time you start the CMS Administrator Tool, you must select the user type (before login). This determines the security model to be used with the CMS server.

Select CMS Users are Workgroup Users then click OK.
If there are any existing repositories with current user types, use this dialog box to back up all existing repositories in the CMS server.

The repositories to be backed up display in the list box.

Click the **Browse** button to specify the backup location, then click **OK**.

The **Log on to CMS server** dialog box displays.

2. Enter a **Name** and **Password**, then click **OK**. The **CMS Administrator** dialog box displays.
3. Select the **Create a new Repository** option and click **OK**.

4. The **Create New Repository** dialog box displays. Enter the path or click **Browse** to find the repository location. To create a new repository folder, click **Browse** to open the **Browse For Folder** and select **Make New Folder**.

5. Enter the folder and the name of the repository and click **OK**. The **CMS Administrator** screen displays.
**Working Folder**

To prevent errors during checkout and checkin, network-shared folders should not be used as local working folders. Users should maintain working folders on their hard drives. Before checkin of a .tcw file, verify that it does not contain any Watch Window names with special characters or spaces. CMS does not recognize special characters.

CMS has two types of working folders:

- Repository working folders are the root folder location for systems from the repository.
- System working folders have a folder location for each system configuration added to the repository, or obtained from the repository.

**Note** Working folders are specific to a particular user. Different users cannot designate the same working folder.

If a user attempts to use a working folder already selected by another user, the following message displays:

![CMS Message](image)

**Repository Working Folder**

The repository working folder is the primary root folder location for a user. Before adding a system to CMS, the system configuration files are copied under the user’s repository working folder, then added to CMS. Each user must specify a repository working folder the first time they log on to CMS. A dialog box displays to enter this information.

**Note** Anytime CMS requests a working folder, it is requesting the repository working folder.
The user must enter the root location as the working folder, not the system working folder (described in next section).

CMS maintains a list of users and their repository working folders on each computer. The repository working folder for a user is only shown in the CMS Stand-alone client (with repository name selected).
System Working Folder

Similar to the repository working folder, the system working folder must be unique for each user. However, each user’s system working folder is initially determined in one of two ways:

- If the user is adding the system to the repository, that user’s system working folder is set to the current location of the system configuration.
- If a new user performs a Get Latest command on a system that was not added by them, the system working folder defaults to a location under the repository working folder (and the Get Latest command places a copy of the system configuration in that location).

The system working folder is not the repository working folder. Typically, the system working folder is located in the repository working folder (but it can also be in any folder). This location can also be changed from within the Stand-alone client (but is not recommended).

The user’s system working folder is shown in the Stand-alone client when a system name is selected.
For the Integrated client, the current folder location of the system (.tcw file) is assumed to be the working folder for that user. The CMS logon fails, and an invalid working folder dialog box displays if a different user is associated with the system in that location.

**Add System / System Working Folder**

When a system configuration is added to CMS, several things occur:

- A copy of the system is placed in the repository. This serves as the starting point to begin CMS revision tracking for all CMS users.
- The user’s system working folder is set to the current location of the system configuration.
- Changes are made to the system in the system working folder for use by CMS.
  - A CVS folder (hidden) is added at the system level and in each component in the system
  - System and component configuration files (cf.dat and .xml) are made Read-only

Once a system configuration is added to the repository, any user can log on to the CMS Server to begin using CMS. After log on, the user obtains the current copy of the configuration (Get Latest), modifies a component (Check Out), then saves the changes (Check In).
Recommendations

- Use only one CMS user and one working folder for all workstations. This user should have administrator privileges.

- When accessing a system through CMS for the first time, use the Stand-alone client to log on and assign the working folder.

- Do not add system to a different repository through the Integrated client. Do not add a system through the Integrated Client. If you choose to do this, make sure to first save the desired system’s .tcw file to the working folder and add it to the selected repository from that location.

- The following are recommended settings to enable auto log in to the CMS Integrated Client when a system configuration is opened in the ToolboxST application.

In the System View, select the Options menu, Settings, System Options, and General. Then set Load Last System to True.
In the System View, select the Options menu, Settings, System Options, CMS, and General. Then set Get Latest Files to True and Work Local to False. Also, set the CMS User Name to the one designated user.
The CMS Stand-alone client allows you to Check Out individual components of a master configuration (.tcw file), make edits, and then Check In the component.

**Opening the CMS Stand-alone Client**

- To open the CMS Stand-alone client
  - From the **Start** menu, select **All Programs**, **GE ControlST**, and **ToolboxST**. Click **Configuration Management System**. The **CMS – Login** dialog box displays.
  
  ![](image)

  **CMS - Login**

  **Configuration Management System**

  - **CMS Server**: 3.212.154.123
  - **User Name**: 105039957
  - **Password**: 
  - **Repository**: TestRepository

  Verify, or enter the IP address for the **CMS Server** where the repository is located. Enter the **User Name** and **Password**, then select the **Repository** from the drop-down list. Click **OK**.

  **Note** The repositories available are those that were created using the CMS Administrator.
The **Configuration Management System** window displays.

The **Systems View** displays a repository as an item that contains systems.

The **Component View** displays all components within the system that is currently selected in the **Systems View**.

The **Log View** displays all messages, events, and error associated with the selected component.

---

**Adding a System to a Repository**

After successfully logging on, you can add systems to a repository.

➢ **To add a system to a repository**

1. From the **File** menu, select **Add System**. The **Add System** dialog box displays.

2. Locate and select the system to be added, then click **OK**. The system displays in the **Tree View**.

Or

From the **Tree View**, right-click the **Repository** item and select **Add System**. The **Add System** dialog box displays.

Locate and select the system to be added then click **OK**. The system displays in the **Tree View**.

---

**Note** When a system is added to a repository, the current folder where the system is located becomes the working folder for that system.

**Note** Once a system is added, all CMS operations are enabled.
Getting the Latest Version

➢ To get the latest version

From the Tree View, right-click the system item, then select Get Latest Version. The Recursive Get dialog box displays.

Note A Recursive Get command retrieves a copy of the system, as well as all configured components.

If a component is checked out, the Overwrite Components dialog box displays. Select any components to overwrite, then click OK.
## CMS Stand-alone Client Menus

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Use to</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Connect to Server</td>
<td>Connect to the correct server to log on to CMS.</td>
</tr>
<tr>
<td></td>
<td>Log In</td>
<td>Log on to the CMS server.</td>
</tr>
<tr>
<td></td>
<td>Log Out</td>
<td>Log off the CMS server.</td>
</tr>
</tbody>
</table>
|          | Add System       | Add a new system to the CMS Stand-alone client. Enter a name for the system, then browse to the configuration file, for example, a .tcw file.  
**Note**: If Missing displays in the Status column, do a Get Latest Version.  
**Note**: Select the repository item to display the system in both the Systems and the Component View; select the system item to display the component(s) in the Component View. |
|          | Delete System    | Delete an existing system from the CMS Stand-alone client.          |
|          | Set Working Folder| Change the path to the destination folder for checking out and checking in system configuration files. |

<table>
<thead>
<tr>
<th>View</th>
<th>Refresh</th>
<th>Get the current system status. The status conditions include: Equal, Checked Out, Unknown, or Missing.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Repository</td>
<td>Clear the Log View of all error and event information.</td>
</tr>
<tr>
<td></td>
<td>Clear Status</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Window</td>
<td></td>
</tr>
</tbody>
</table>

| Source   | Get Latest Version| Retrieve the last checked-in version of the configuration files from the repository. Components under CMS control will always be Read-Only until the component is Checked Out.  
**Attention**: When you perform a Get Latest Version, all files that you currently have checked out are overwritten. |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Check In</td>
<td>Check a file back into the repository and save changes.</td>
</tr>
<tr>
<td></td>
<td>Check Out</td>
<td>Check a file out of the repository to make changes.</td>
</tr>
<tr>
<td></td>
<td>Undo Check Out</td>
<td>Return a checked-out file to the repository without saving changes.</td>
</tr>
<tr>
<td></td>
<td>Label</td>
<td>Mark the current repository component with a text label. If the label is assigned to the system component, the system and all components in the system are assigned the same text label. The label displays in the History screen when you select Show History. The label can be used for specific version identification, as well as for future file retrievals.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tools</th>
<th>Change Password</th>
<th>Change your password for logging onto CMS.</th>
</tr>
</thead>
</table>
|          | Show Differences | Display the differences between the master copy in the repository and the local copy in the working folder.     
**Note**: From the Show History window, you can select a version and click the Diff button to compare the selected version in the repository with the local copy in the working folder. You can also select two versions and click the Diff button to compare the two selected versions in the repository. |
|          | Show History     | Display the versions/modifications for a selected configuration file.                                              
**Note**: From the Show History window, you can select a version and click the Diff button to compare the selected version in the repository with the local copy in the working folder. You can also select two versions and click the Diff button to compare the two selected versions in the repository. |

<table>
<thead>
<tr>
<th>Help</th>
<th>Contents</th>
<th>Open the help file for the Stand-alone Client.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>About</td>
<td>Display the software version information.</td>
</tr>
</tbody>
</table>
A sample Show History dialog box is shown below.

Label is additional text to identify a specific version.

Sequential version numbers assigned to each change at check in.

User that made the change.

User comments entered at check in.
**CMS Integrated Client**

The Integrated client provides many of the Stand-alone client functions from within the ToolboxST application. It allows you to check out individual components of a master configuration, make edits, and then check in the component. The Integrated client is accessed through the ToolboxST application.

**Note**  The CMS menu item is disabled until a system is opened.
The CMS Integrated client operation is controlled by ToolboxST option settings saved at each computer.

- **To configure CMS settings**
  - From the **ToolboxST Options** menu, select **Settings**. The **Settings** dialog box displays.

  ![Settings Dialog Box](image)

  **UserName** is the default user name used to logon to CMS.

  **Get Latest Files**, when set to True, gets the latest version upon logon.

  **Work Local**, when set to True, opens the system disconnected from the CMS server. This is the default when the ToolboxST application is installed, and opens the system without the CMS Integrated client.

  **Work Local**, when set to False, opens the system connected to the CMS server, and displays the CMS LogIn dialog box.
Opening the CMS Integrated Client

- To open the Integrated client

  - From the Start menu, select All Programs, GE ControlST, ToolboxST, and then ToolboxST.

The CMS - LogIn dialog box displays.

**Note** You must connect to the correct CMS server to log on.

**Note** The CMS - LogIn dialog box does not automatically display unless the ToolboxST Work Local option was set to False.
Enter the **User Name** and **Password**, then select the **Repository** from the drop-down list and click **OK**.

If you clicked **Cancel**, you are not logged into CMS. One of three scenarios occurs, depending upon your local ToolboxST settings.

An empty ToolboxST window displays, a local system opens, or a Read-Only system opens.

- To access a system file
  - Select **File** and **Open System**. Browse to the working folder you created, then select the ToolboxST system .tcw file. The .tcw file opens in Read-Only mode.
➢ **To change the server (if not logged on)**

1. From the ToolboxST CMS menu, click **Connect to Server**. The CMS – **Server Details** dialog box displays.

![CMS - Server Details](image)

Enter the **IP Address** or **Name** of the computer on which the server is installed, then click **OK**.

2. When the CMS – **LogIn** dialog box displays, enter your **User Name** (if not displayed), **Password**, and **Repository**, then click **OK**.

**Note** If a question mark icon displays next to the system item in the ToolboxST System Editor Tree View, perform a Get Latest Version.
# CMS Menu Items

<table>
<thead>
<tr>
<th>Command</th>
<th>Use to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect to Server</td>
<td>Connect to the correct server to log on to CMS.</td>
</tr>
<tr>
<td>Login</td>
<td>Log on to CMS Server from the CMS Integrated client.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: You must be connected to the correct server to log on.</td>
</tr>
<tr>
<td>Logout</td>
<td>Log off the CMS Server from the CMS Integrated client.</td>
</tr>
<tr>
<td>Work</td>
<td>Use ToolboxST without CMS.</td>
</tr>
<tr>
<td>Disconnected</td>
<td><strong>Note</strong>: Any changes made while operating in this mode are NOT saved in the CMS repository. CMS menu options are disabled while working disconnected. This mode is for testing.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Refresh the systems and components that display.</td>
</tr>
<tr>
<td>Add System to Repository</td>
<td>Add a new system to the repository you are working in.</td>
</tr>
<tr>
<td>Add System to Different Repository</td>
<td>Add a new system to a different repository. This action is not recommended.</td>
</tr>
<tr>
<td>Get Latest Version</td>
<td>Retrieve the last check-ed in version of the configuration files from the repository. Components under CMS control will always be Read-Only until the component is Checked Out. <strong>Attention</strong>: When you perform a Get Latest Version, all files that you currently have checked out are overwritten.</td>
</tr>
<tr>
<td>Check Out</td>
<td>Check a file out of the repository to make changes.</td>
</tr>
<tr>
<td>Check In</td>
<td>Check a file back into the repository and save changes.</td>
</tr>
<tr>
<td>Undo Check Out</td>
<td>Return a checked-out file to the repository without saving changes.</td>
</tr>
<tr>
<td>Label</td>
<td>Mark a checked-out copy of the file with identifying text. The label can be used for future file retrievals.</td>
</tr>
<tr>
<td>Show History</td>
<td>Display the versions/modifications for a selected configuration file. <strong>Note</strong>: From the Show History window, you can select a version and click the Diff button to compare the selected version in the repository with the local copy in the working folder. You can also select two versions and click the Diff button to compare the two selected versions in the repository.</td>
</tr>
<tr>
<td>Show Differences</td>
<td>Display the differences between the master copy in the repository and the local copy in the working folder. <strong>Note</strong>: From the Show History window, you can select a version and click the Diff button to compare the selected version in the repository with the local copy in the working folder. You can also select two versions and click the Diff button to compare the two selected versions in the repository.</td>
</tr>
</tbody>
</table>
**Troubleshooting**

If any of the following issues occur, perform the Clean Get procedure below.

- Missing or Unknown status displays for systems and/or components in the Stand-alone and/or Integrated clients
- Message box displays "The same working folder appears to be used by a different user account..."
- Message box displays informing you of CVS issues and states “...cvs [server aborted]: correct above errors first!”

If troubleshooting issues occur, perform a **clean Get** as follows:

1. Open **Windows Explorer**. Navigate to your system working folder.
2. Delete all contents in your system working folder.
3. From the Stand-alone Client window, select **Get Latest Version**.

If a change occurs in the repository or to the IP address of the CMS server, perform the following procedures to clear the CMS working folder data and update the repository and IP address in the .tcw file.

For the **Integrated Client**

1. Locate and open the .tcw file.

**Note** If the .tcw file is read-only, the logon fails.

2. From the system folder, delete the .csv folder.
3. Connect to the CMS server using a new IP address and select a repository.
4. Log on to the system.

**Note** All components display a question mark.

5. Right-click the system item and select **Get Latest Version**. When the **Recursive Get** dialog box displays, click **Yes**.
6. Delete the entire contents of the system folder.
7. Check out the system then check it back in to save changes.

For the **Stand-alone Client**

1. Log on to the Stand-alone Client using a new IP address and select a repository.

**Note** All components display as unknown.

2. Right-click the system item and select **Get Latest Version**. When the **Recursive Get** dialog box displays, click **Yes**.
3. Delete the entire contents of the system folder.
4. Check out the system then check it back in to save changes.
Chapter 12 Tree File Importer

The Tree File Importer is a companion application that converts software tree files from the Control System Toolbox application to the new .xml file format used by the ToolboxST application.

The Tree File Importer helps the conversion process by providing a baseline for further revision and refinement. As configuration files produced by the converter may contain errors and/or omissions, all converted components and library containers must be thoroughly reviewed and verified before use. A failure to thoroughly verify any software or configuration may result in equipment damage and/or malfunction and subsequent bodily harm or loss of life.

To use the Tree File Importer

1. From the Control System Toolbox, export the tree files for a particular device using the Export All command on the File menu. Make sure the device is valid before proceeding.

2. From the ToolboxST application, create a system, add a library container, and then add an empty component corresponding to the device type that you exported from the Control System Toolbox. (The ToolboxST application uses the term component in place of the older term device from the Control System Toolbox.)

3. Run the Tree File Importer. Select the system and library container you created in Step 2, then select the project file from Step 1 to import the macro and module library tree files. Each use of the Tree File Importer imports a single file; importing a project file includes all tree files for a device and is the quickest way to perform a conversion. Refer to the section, Running the Tree File Importer.

4. From the ToolboxST System Editor, open the controller and add a reference to the libraries that were imported in Step 3.

5. Exit the ToolboxST application and return to the Tree File Importer. Select the system and device you created in Step 2, then select the project file from Step 1 to import the function tree files.

Note  Information from Control System Solution toolbox system files (files ending in .syb) are not imported. This includes scales, enumerations, and resources. Use the toolbox SDB browser to display this information in the ToolboxST system information editor.
Running the Tree File Importer

Before beginning, make sure you have created a system to contain the imported configuration and that the system contains a component of the correct type. (For example, you would need a system with at least one Mark VIe component to import a Mark VIe controller configuration.) Also, make sure that the ToolboxST application is not running.

➢ To run the Tree File Importer

1. From the Start menu, select Programs, GE ControlST, ToolboxST, and then Tree File Importer to display the Tree File Importer wizard.
2. Click the **Browse** button. From the **Open Workplace** window, locate and select the system .tcw file containing the component to receive the imported configuration, then click **Open**. Click **Next** to continue to Page 2 of the Wizard. The ToolboxST application opens the system and displays a list of available controller and library container components.
Click the arrow and select All Files to display all available files.

3. From the Select Project or Tree File screen, locate and select a source .prj or .tre file, and then click Open. When you have selected a source file, click Next to begin the import process.

4. The Application Code Conversion Type dialog box opens. Unless you are certain another setting applies, select Straight variable name conversion, then click OK.
When the import process is completed, Page 4 of the wizard displays with a log of errors and warnings that occurred. Warnings are minor problems that do not prevent the import from being saved (for example, a function block that cannot be imported). Errors are major problems that prevent the import from completing (for example, a missing library reference.)

---

**Warning**

Errors and Warnings displayed by the Tree File Importer are designed to provide helpful information about the import process. They are by no means complete, and the lack of any errors or warnings does not necessarily indicate that a fully functioning and correct component was created by the import. Before using any application code or settings imported by the wizard, thoroughly review every aspect of the system for errors, omissions and/or inconsistencies.

---

5. After reviewing the log, click **Next** to save the updated system and complete the wizard.

6. Click **Finish** to exit the wizard.
Chapter 13 Special I/O Functions

Several I/O functions are available with the Mark VIe component as follows:

- Valve calibration
- Multicasting
- Configuring an enabled analog I/O module
- Configuring PROFIBUS communications
- Retrofitting a Mark VIe component

Calibrating Valve Circuits

Valve calibration allows you to configure the valve circuits of the servo control (PSVO) pack (refer to GEI-100586, Mark VIe PSVO Servo Control), the core analog (PCAA) module (refer to GEI-100612, Mark VIe PCAA Core Analog Module), and the PSVP servo pack (refer to GEI-100741, Mark VIe PSVP Servo Control Module – Steam). The Calibrate Valve dialog box provides an automated sequence as well as a verification mechanism to configure and maintain values for each valve circuit.

Note Only one valve can be calibrated at one time.

➢ To calibrate valve circuits

1. From the Component Editor, click the Hardware tab.
2. From the Tree View, select the desired PSVO, PSVP, or PCAA.
3. From the Summary View, select the Variables tab, and then click the On/offline button on the taskbar to go online.
4. In the Variables tab, scroll to CalibEnab1, then double-click it in the row header.

Note Only enabled regulators can be calibrated.

5. From the Summary View, click the Regulators tab.
6. From the Regulators drop-down list, select the desired regulator.
7. Click to select the Enable check box.
8. Click the **Calibrate** button. The **Calibrate Valve** dialog box displays.

![Calibrate Valve dialog box](image)

9. Click the **Calibration Mode** button to enable all command buttons and to start the calibration command in each I/O pack. A Trender window displays dynamic signals.

**Note** Do not make any changes to the regulator configuration during valve calibration. Each calibration command is monitored by the ToolboxST application to verify performance.

10. To exit calibration mode, click the **Calibration Mode** button again.

Auto Calibrate commands occur in the following sequence:

1. Click **Minimum End** to stroke the actuator to the minimum end position.
2. Click **Fix Minimum End** to read the voltage at the minimum end position.
3. Click **Maximum End** to stroke the actuator to the maximum end position.
4. Click **Fix Maximum End** to read the voltage at the maximum end position.
5. Click **Calibrate** to use the calculated values.
6. Click **Save** to save the calculated values.

**Note** Only one command state can be active at any one time.
The calculated values are saved to the application code area of each I/O pack, and to the current configuration loaded in the ToolboxST application.

Verification commands, which are not performed in any sequence, are as follows:

- Click **Position** to step and monitor the position.
- Click **Current** to step and monitor the current.
- Click **Manual** to enable manual movement of the actuator (used in conjunction with the **Send** button).
- Click **Send** to send the value in the SetPoint textbox to the I/O pack.
- Click **OFF** to exit verification mode.

---

**Note**  
LVDT voltages are the values that represent the minimum and maximum actuator positions stored in the I/O pack. These values are not live data. They display after the Save button is selected.

The ToolboxST application monitors the calibration permissive and calibration command. If the permissive is lost, all calibration and verification buttons on the dialog box are disabled. If the calibration command cannot be activated or is lost, all calibration and verification buttons, with the exception of the Calibration Mode button, are disabled.

**Availability**

This function is available with the following packs:

- Servo Control (PSVO)
- Core Analog (PCAA)
- Servo Control (PSVP)
**Multicasting**

A ToolboxST function called power load unbalance (PLU) allows you to configure a multicast connection between a PGEN I/O module and a PDOA I/O module on the same IONet.

- **To configure multicasting**
  1. From the **Component Editor**, click the **Hardware** tab.
  2. From the **Tree View**, right-click the **Distributed I/O** item and select **Add Module** to display the **Add Module Wizard**.

![Add Module Wizard](image)
3. When the module configuration information displays, click **Finish**.
4. From the **Hardware tab** Tree View, right-click the **Distributed I/O** item and select **Add Module** to display the **Add Module Wizard**.

From the I/O Module Trip from drop-down list, select **PGEN[PLU]-21**, then click **Next**.

5. When the module configuration information displays, click **Finish**.

**Availability**

This function is available with the following packs:

- Turbine-Generator Monitor (PGEN)
- Discrete Output (PDOA)
Configuring a HART Device

Note To add HART I/O devices to a component configuration, a PHRA module (refer to GEI-100597, PHRA HART Enabled Analog Input/Output) must be added in a cabinet group in the Mark VIe Component Editor Hardware tab.

➢ To configure PHRA module for HART Devices

1. From the Component Editor, click the Hardware tab.

2. From the Tree View, select the PHRA I/O module.

3. From the Summary View, click the Parameters to configure PHRA module for an Asset Management System (AMS), if applicable.

4. From the Summary View, click the Inputs and Outputs tabs. Enable and configure each input and/or output needed for the HART devices.

Note I/O Input Type must be configured for 0-20ma.
To upload HART device IDs

1. From the Component Editor, click the Hardware tab.
2. From the Tree View, select the PHRA I/O module.
3. Right-click module and click Upload Hart IDs.

Availability

This function is available with the HART Enabled Analog I/O (PHRA).
PROFIBUS Communications

The PROFIBUS master gateway (PPRF) is a PROFIBUS DPV0, Class 1 master
that maps I/O from PROFIBUS slave devices to Mark VIe controllers on the
I/O Ethernet (refer to both GEI-100614, PPRF PROFIBUS Master Gateway and
GEH-6721, Mark VIe Control System Guide, Vol II, the section PPRF PROFIBUS
Master Gateway). There are two redundancy options:

- **Simplex** provides a single I/O pack gateway to the PROFIBUS network.
- **HotBackup** provides dual I/O packs, with one active gateway and one backup.

*Note* Only one I/O pack can be actively communicating with its associated
PROFIBUS network.

➢ To add a PPRF module

1. From the Component Editor, click the Hardware tab.
2. From the Tree View, right-click the Distributed I/O item and select Add
Module. The Add Module Wizard dialog box displays.

![Add Module Wizard](image)

Select the I/O Pack Redundancy type: either **Simplex** (if one I/O pack is
present) or **HotBackup** (if dual I/O packs, one active and one backup, are
present).

Select the PPRF module, then click **Next**.
Use the **Version** drop-down list to select a module version. Listed module versions depend on the available compatibility codes.

Click the **Release Notes** button to view additional information about the currently selected module version.

If the **Module Required** check box is selected, the module must be present and functioning for the controller to go online.

Click **Next** to preview configuration information.
The image shows a window titled "Add Module Wizard" with the following configuration details:

**Module Configuration**
- **Name**: PPPF-23
- **I/O Packs**: 1
- **Bar Code**: 0000000
- **Required**: Yes

**Terminal Board Configuration**
- **Name**: SPID
- **HW Forms**: G1A
- **Group**: Distributed I/O
- **Position**: 23

**I/O Pack Configuration**

<table>
<thead>
<tr>
<th>I/O Pack</th>
<th>HW Form</th>
<th>Connector</th>
<th>Port A</th>
<th>Port B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>H'1A</td>
<td>J41</td>
<td>IoNet1</td>
<td></td>
</tr>
</tbody>
</table>

Click **Finish** to add the new module.
Adding a Slave Device

To add a PROFIBUS slave device

1. From the Component Editor Tree View, right-click the Distributed I/O item, then select GSD Manager.

Note The GSD Manager is not available until a PPRF module has been added.

2. Select a file(s), then click the Add File button.

The GSD Manager dialog box displays.

The GSD Manager dialog box displays.

The Add File button adds selected PROFIBUS device file(s) to the configuration.

The Remove File button removes selected PROFIBUS device file(s) from the configuration.
3. From the **Hardware** tab, **Tree View**, highlight the PPRF module, then click the **PROFIBUS Network** tab in the **Summary View** to configure the network.

4. From the **Device** view, insert the slave device into the network by selecting and dragging the device to the purple-colored line in the **PROFIBUS Network** view.

*Note* Any changes made in the PROFIBUS Network tab cannot be undone through the ToolboxST Undo option under Edit.
The slave device opens with the Modules view displayed. From the Available Modules list, select the desired module. Then either double-click the module name or click the Append button to add this module to the Configured Modules list. You can also click the Insert button to add the module before the selected configured module.

Click the Remove button to remove a selected module from the Configured Modules list.

If a change is made, click the Apply button, then click OK to return to the Hardware tab.

**Note** If any changes are made to the slave device configuration and the OK button is clicked, the pack is restarted after the controller and pack are downloaded.

The Station Address, which is read-only from this view, displays the device address.

Click to enable Watchdog Control, which allows this device to enter fail-safe mode if an error occurs. The Interval is the time period that elapses before fail-safe mode. The default time interval is 200 ms.

Click the OK button to return to the Hardware tab.
5. From the **Tree View**, click the **Parameters** item to configure parameters for this module.

Select a parameter, then use the drop-down list to set the value.

Click the **OK** button to return to the Hardware tab.

6. From the **Tree View**, click the **Groups** item to add the slave device to an I/O group.

**Note** Groups are not supported by the PPRF.
7. From the **Tree View**, click the **Extensions** item to configure advanced values for this device.

8. From the **Tree View**, click the **DPV1** item to display the screen below.

   **Note** This screen is only active if DPV1 is supported by this device, but this feature is not supported by the PPRF.
9. From the **Tree View, Device Description**, click the **Device** or the **GSD** items to display information about the slave device.

10. From the **Tree View**, click the **GSD** item to display the contents of the GSD file(s).
Configuring the Master Device

To configure the master device

In the Hardware tab Summary View, PROFIBUS Network tab, double-click on the PPRF device.

The `netDevice` window for configuring the master device displays.

Select a master device profile from the drop-down list.

**Bus Parameters** displays PROFIBUS network properties.

**Bus Monitoring** displays how the PROFIBUS network will be monitored by the gateway.

*Note* If any changes are made to the master device configuration and the OK button is clicked, the pack must be restarted after the controller and the pack are downloaded.
**Enabling a Slave Device**

- To enable the slave device
  - From the **Tree View**, click **Station Table** to display the window below.

![Image of Station Table](image1)

**Displaying the PROFIBUS Network**

- To display the PROFIBUS network overview
  - From the **Tree View**, click the **Address Table** item. The **Address View** displays.

![Image of Address View](image2)
To configure I/O variables

From the Hardware tab, Tree View, select a slave device.

The following information displays in the Summary View.

The Variables data grid displays the PROFIBUS configuration, which is defined as a number of module input and output bytes or words. By default, slave inputs are followed by slave outputs. Successive rows may be grouped as necessary to create actual point values that span multiple rows. Packed Boolean values are expanded into a separate data grid as shown so that Boolean Mark Vle variables can be attached to the individual bits. The Variables tab contains the following columns.

<table>
<thead>
<tr>
<th>Connected Variable</th>
<th>Var Data Type</th>
<th>Fieldbus Point Data Type</th>
<th>Direction</th>
<th>Module</th>
<th>Fieldbus Point Offset</th>
<th>Size</th>
<th>Input</th>
<th>Input Count Enabled</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>I2DL</td>
<td>Boolean</td>
<td>Input</td>
<td>Input</td>
<td>1</td>
<td>1</td>
<td></td>
<td>0</td>
<td>False</td>
<td>input_2:1</td>
</tr>
<tr>
<td>INT</td>
<td>Boolean</td>
<td>Input</td>
<td>Output</td>
<td>2</td>
<td>1</td>
<td></td>
<td>0</td>
<td>False</td>
<td>output_3:1</td>
</tr>
<tr>
<td>REAL</td>
<td>Real</td>
<td>Input</td>
<td>Input</td>
<td>3</td>
<td>1</td>
<td></td>
<td>0</td>
<td>False</td>
<td>input_3:3</td>
</tr>
<tr>
<td>REAL</td>
<td>Real</td>
<td>Input</td>
<td>Input</td>
<td>4</td>
<td>1</td>
<td></td>
<td>0</td>
<td>False</td>
<td>input_3:5</td>
</tr>
</tbody>
</table>

Note: The Direction, Module, and Fieldbus Point Offset columns are read-only.

The Connected Variable column displays the connection to other defined variables in the ToolboxST application.

The Var Data Type column displays the data type of the variable configured in the Mark Vle component. Space can be reserved for unused inputs and outputs, enabling subsequent online loads when variables are added.

The Fieldbus Point Data Type column displays the data type of the slave device I/O point. If the size of the point spans multiple rows of input or output bytes or words, subsequent rows display Continued. The default byte data type for rows associated with configuration bytes must be changed to a supported data type shown in the table below.

---

**Note** The Direction, Module, and Fieldbus Point Offset columns are read-only.
<table>
<thead>
<tr>
<th>PROFIBUS Point Data Type</th>
<th>Mark VIe Variable Data Type</th>
<th>Scaling</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>Boolean</td>
<td></td>
</tr>
<tr>
<td>Integer16</td>
<td>Integer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Float</td>
<td>✓</td>
</tr>
<tr>
<td>Integer32</td>
<td>Double integer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Float</td>
<td>✓</td>
</tr>
<tr>
<td>Unsigned16</td>
<td>Unsigned integer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Float</td>
<td>✓</td>
</tr>
<tr>
<td>Unsigned32</td>
<td>Unsigned double integer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Float</td>
<td>✓</td>
</tr>
<tr>
<td>Floating point (32 bits)</td>
<td>Float</td>
<td>✓</td>
</tr>
</tbody>
</table>

**Note** Only certain point-to-variable data transfer conversions are supported.

**Raw Min, Raw Max, Eng Min**, and **Eng Max** are values used to calculate scaling from raw units (the PROFIBUS point) to engineering units (the Mark VIe variable).

**Boolean** transfers are expanded into individual bits and displayed in the Booleans tab below the Variables tab.

**Input Event Enabled**, if set to True, enables input event scanning on a Boolean transfer.

**Note** An input event is similar to an SOE, but has a 10ms resolution.

Any field except Var Data Type and Fieldbus Point Data Type it can be modified without restarting the controller or I/O pack.
To configure PROFIBUS diagnostics

From the Hardware tab, Tree View, click the PPRF, then click the PROFIBUS Diagnostics tab.

<table>
<thead>
<tr>
<th>Summary</th>
<th>Variables</th>
<th>PROFIBUS Network</th>
<th>PROFIBUS Diagnostics</th>
<th>Diagnostics</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProfibusDiag</td>
<td>read</td>
<td>BOOL</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If any PROFIBUS device generates a non-status only diagnostic, the ProfibusDiag variable has a value of True. For applications that require diagnostic presence indication, attach a defined BOOL-type variable to ProfibusDiag.

Non-status diagnostics are ones that indicate problems. Status-only diagnostics contain only the standard portion (the first six octets). These, in addition to the master address and identification number, have one or more of the following diagnostics values set.

- Master_Lock (slave parameterized by another master; octet 1, bit 7)
- Bit always set to True (octet 2, bit 3)
- WD_On (watchdog on; octet 2, bit 3)
- Freeze_Mode (slave freeze mode activated; octet 2, bit 5)
- Sync_Mode (slave sync mode activated; octet 2, bit 5)
- Reserved bits (octet 3, bits 0-6)
- Ext_Diag_Overflow (slave error message overrun; octet 3, bit 7)

Note: The connected variable may be added, changed, or removed and loaded without restarting the controller or I/O pack.
The values that display in the Standard Diagnostics tab are the standard portion of a PROFIBUS diagnostic message (the first six octets). Except for the Master_Addr (master address) and Ident_Number (identification number) values, which are UINT types, the remaining values are BOOL types. The connected values must have matching data types.

**Note** The last value in the Standard Diagnostics tab, Station_Diagnostic, is not part of the PROFIBUS standard diagnostic message. It provides a station diagnostic present indication. It is set to True if the slave device generates a *non-status* only diagnostic. For applications that require station diagnostic presence indication, attach a defined Boolean-type variable to the Station_Diagnostic.
The Device Diagnostics Tab

The byte offset range is 0-61. The bit offset range is 0-7. The Bit length range is 0-8. This must be 0 for multi-byte data widths, 1 for BOOLS, and 1-8 for bit fields (which may not cross byte boundaries).

The connected variable must be a BOOL if the bit length is 1, or an integer if the bit length is 1-8. When the bit length is 0, the variable’s data type determines the byte length.

The Device Diagnostics tab, which is initially empty, is used to connect variables to data fields within the Device-related portion of a diagnostic message. Entries in the Diagnostic Byte Off, Diagnostic Bit Off, and Diagnostic Number Of Bits columns identify bits, bit fields, and analog values within the Device-specific diagnostic, which is exclusively defined on a per-device basis.

- **To specify a bit-wide diagnostic value**
  - Enter the byte and bit offset values, then enter 1 in the Diagnostic Number of Bits column.

You can also connect a Boolean-type variable to the specified diagnostic bit. (If the connected variable is not provided, it may be added and downloaded. However, since the ToolboxST configuration assumed an integer type because of the blank variable field, the I/O pack is restarted.)
➢ **To specify a bit field diagnostic value**

- Enter the byte and bit offset values and the **Diagnostic Number of Bits** value.

The specified bit field must fit within an 8-bit boundary and may extend from 1 to 8 bits. You can also connect an integer variable (not a BOOL or FLOAT).

A connected variable can be added and downloaded later without restarting.

➢ **To specify an analog diagnostic value**

- Enter the byte offset value, then enter 0 for the bit offset and number of bits.

The analog value, which must fit within a 32-bit boundary, is treated as a *BigEndian* (high byte followed by low byte) value. You can also connect an analog variable to define the data type of the diagnostic value. (A connected variable can be added and downloaded later without restarting.) No type conversions are performed.

---

**Note**  The I/O pack must be restarted if lines are added or removed from the Data Grid, or if an existing entry’s connected value is changed from a Boolean to an analog-type or vice versa. All other changes to existing entries can be made and downloaded without restarting the controller or I/O pack. To add a line without specifying the connected variable, you must enter a space in the Connected Variable field to enable the other fields for data entry.
The Identifier Diagnostics tab, which is initially empty, is used to connect variables to bits within the Identifier-related portion of a diagnostic message. Each bit, which corresponds to a module in the slave device, is set to True to indicate a problem.

➢ **To specify an identifier diagnostic**

- Enter the **Identifier Number** and (optionally) connect a BOOL-type variable.

**Note** If lines are added or removed from the Data Grid, the I/O pack must be restarted after being downloaded. Existing Data Grid modifications (adding, removing, or changing connected variables, changing the Identifier Number and such) can be downloaded without restarting the controller or the I/O pack.

To add a line without specifying the connected variable, you must enter a space in the Connected Variable field to enable the other fields for data entry.
**Channel Diagnostics**

The **Identifier Number** range is 0-495.

The **Channel Number** range is 0-63.

Select the **Channel Direction** and **Diagnostic Type** from the drop-down lists.

The **Data Type** for the **Connected Variable** must be an **UINT**.
The Channel Diagnostics tab, which is initially empty, is used to connect variables to the type octet of the Channel-related portion of a diagnostic message. The channel diagnostic type octet contains two fields, a 3-bit channel type, and a 5-bit error type, whose values are defined in the PROFIBUS standard. (The error type field values of 16-31 are manufacturer-specific).

➢ **To specify a channel diagnostic**

- Enter the **Identifier Number, Channel Number, Channel Direction**, and **Diagnostic Type**, and optionally connect a UINT-type variable. (A connected variable can be added and downloaded later without restarting.)

**Note** If lines are added or removed from the Data Grid, the I/O pack must be restarted after it is downloaded. Existing Data Grid modifications (adding, removing, or changing connected variables, changing the Identifier Number and such) can be downloaded without restarting the controller or the I/O pack.

To add a line without specifying the connected variable, you must enter a space in the Connected Variable field to enable the other fields for data entry.

➢ **To display advanced diagnostics**

- From the **Hardware** tab **Tree View**, right-click the PPRF, then select **Troubleshoot Module** and **Advanced**. The **Advanced Diagnostics Commands** window displays.

**Note** The system must be running, and the ToolboxST application must be able to connect to the Mark VIe component.

The Advanced Diagnostics window below displays no diagnostics.
An example of a PROFIBUS diagnostic is shown below.

**Availability**

This function is available with the PROFIBUS Master Gateway (PPRF).

---

**Mark Ve Retrofit**

The Mark Ve PMVE control I/O pack (based on the UCSx processor board) is an I/O subsystem that communicates and controls one or more I/O agents across the high-speed serial link (HSSL). The PMVE currently supports the MVRA and MVRF boards in a TMR configuration, as well as an MVRC board in a simplex configuration. Refer to GEI-100689, *PMVE Control I/O Pack*.

**Availability**

This function is available with the Control I/O Pack (PMVE).
Configuring a PCNO Module

The CANopen Input/Output (PCNO) pack is an NMT CANopen master that maps I/O from either CANopen Woodward GS6 or GS16 valves to Mark VIe controllers on the I/O Ethernet. Refer to GEI-100737, PCNO CANopen Master Gateway.

A PCNO module is added from the Hardware tab. Refer to Chapter 6, the section Hardware Tab, for instructions to add a module.
To configure a PCNO module

- From the Tree View, expand the PCNO item. Each PCNO module supports up to five CANopen slave devices.

The CANopen node-id and the device number are the same. For example, if a GS6 fuel valve is attached to Device 2, the CANopen node-id number is 2.

Variables tab

Click the ellipsis button in the Connected Variable column to display the Select a Variable dialog box and add a variable.

Note Each configured PCNO module supports up to five GS16 or GS6 fuel valves. CANopen devices cannot be mixed.
The Variables tab contains a list of counters that provide an indication of CANopen message transmission and reception. Each time the pack sends a message to a slave device, the corresponding RPDO count is incremented. Each time the pack receives a message from a slave device, the corresponding TPDO count is incremented.

A connected variable can be changed with an online load. Adding or removing CANopen devices requires an offline load.
Configuring a PMVE Module

The Mark* Ve PMVE control I/O pack (based on the UCSx processor board) is an I/O subsystem that communicates and controls one or more I/O agents across the high-speed serial link (HSSL). Refer to GEI-100689, Mark VIe PMVE Control I/O Module.

A PMVE module is added from the Hardware tab. Refer to Chapter 6, the section Hardware Tab, for instructions to add a module.
Adding MVRA, MVRB, or MVRF

➢ To add an MVRA, MVRB, or MVRF board

1. From the Component Editor, click the Hardware tab.

2. The Configure Sub-Assembly dialog box displays.
3. Make desired changes to the configuration, then click **OK**.

**Note** To add additional modules, select another Port item and follow the same procedure.
I/O Setup Pack Wizard

➢ To configure the PMVE I/O pack

1. From the Hardware tab Tree View, right-click the PMVE module and select Setup. The I/O Pack Setup Wizard displays.
2. When the Welcome wizard displays, click **Next**.

Select **Configure Network Address** or **Format Flash** and click **Next**.

This option is only necessary when you desire to change the UCSx-based I/O pack address. You will need a serial connection from your computer to UCSx-based I/O pack. You do not need to perform this operation if you have just formatted the flash.
Click Next to continue. The next wizard screen displays the progress of the connection. When it is complete, click Finish.
Glossary of Terms

application code Software that controls specific machines or processes.

attributes Information, such as location, visibility, and type of data that sets something apart from others. In signals, an attribute can be a field within a record.

baud A unit of data transmission. Baud rate is the number of bits per second transmitted.

bit Binary Digit. The smallest unit of memory used to store only one piece of information with two states, such as One/Zero or On/Off. Data requiring more than two states, such as numerical values 000 to 999, requires multiple bits (see Word).

block Instruction blocks contain basic control functions, which are connected together during configuration to form the required machine or process control. Blocks can perform math computations, sequencing, or continuous control. The ToolboxST application receives a description of the blocks from the block libraries.

board Printed wiring board.

Boolean Digital statement that expresses a condition that is either True or False. In the ToolboxST application, it is a data type for logical signals.

bus An electrical path for transmitting and receiving data.

byte A group of eight binary digits (bits) operated on a single unit.

collection A group of signals found on the same network. The Trend Recorder can be configured by adding collections.

configure To select specific options, either by setting the location of hardware jumpers or loading software parameters into memory.

Control Constant Control Constant is a signal with an initial value that is read and never written.

designated controller In a Mark VIe dual controller system, the designated controller (DC) is the controller to which the I/O packs listen for outputs when they have the option to listen to multiple controllers. In a TMR system, the DC is the controller that initializes the other controllers.

device A configurable component of a process control system.

Ethernet LAN with a 10/100 MB baud collision avoidance/collision detection system used to link one or more computers together. Basis for TCP/IP and I/O services layers that conforms to the IEEE 802.3 standard, developed by Xerox, Digital, and Intel.

fault code A message from the controller to the HMI indicating a controller warning or failure.

Finder A subsystem of the ToolboxST application for searching and determining the usage of a particular item in a configuration.

firmware The set of executable software that is stored in memory chips that hold their content without electrical power, such as flash memory.

flash A non-volatile programmable memory device.
One complete collection of letters, punctuation marks, numbers, and special characters with a consistent and identifiable typeface, weight, posture, and size.

Setting a variable signal to a particular value, regardless of the value blockware or I/O is writing to that signal.

A device that connects two dissimilar LANs or connects a LAN to a wide-area network (WAN), PC, or a mainframe. A gateway can perform protocol and bandwidth conversion.

A term that defines whether a variable is functioning as expected.

A signal emitted at regular intervals by software to demonstrate that it is still active.

Base 16 numbering system using the digits 0-9 and letters A-F to represent the decimal numbers 0-15. Two hex digits represent 1 byte.

Input/output interfaces that allow the flow of data into and out of a device.

To set values (addresses, counters, registers, and such) to a beginning value prior to the rest of processing.

Update an item with a new definition.

A statement of a true sense, such as a Boolean.

In a local network, a component that is connected to other components and is capable of communicating with other network devices. In a tree structure, a location on the tree that can have links to one or more nodes below it.

The memory specially designed to store information even when the power is off.

Online mode provides full CPU communications, allowing data to be both read and written. It is the state of the ToolboxST application when it is communicating with the system for which it holds the configuration. Also, a download mode where the device is not stopped and then restarted.

Refers to devices at the electronic or machine level in contrast with logical. Logical implies a higher view than the physical. Users relate to data logically by data element name; however, the actual fields of data are physically located in sectors on a disk.

To restart the controller.

A form of shared memory that is updated over a network. Register pages can be created and instanced in the controller and posted to the SDB.

A ladder diagram has a symbolic power source. Power is considered to flow from the left rail through a contact to the coil connected to the right.

Also known as groups. Resources are systems (devices, machines, or work stations where work is performed) or areas where several tasks are carried out. Resource configuration plays an important role in the CIMPLICITY system by routing alarms to specific users and filtering the data users receive.

A block that can extend to include a variable number of pins.

See product code.

A Windows-based software package used to configure controllers.

A time-based plot to show the history of values.
Trender A subsystem of the ToolboxST application that monitors and graphs signal values from a controller.

validate Makes certain that items or devices do not contain errors and verifies that the configuration is ready to be built into application code.

variable The basic unit for variable information. Variables are the placeholders for memory locations in the toolbox’s different platforms.

word A unit of information composed of characters, bits, or bytes. It is treated as an entity, and can be stored in one location. Also, a measurement of memory length, usually 32 bits in length, but can also be 4, 8, or 16 bits long.